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SYLLABUS 

Class – B.Com-I Year 

Subject – Fundamentals of Computer and PC Software 

Introduction 

A computer is a general-purpose device that can be programmed to carry out a set of arithmetic or logical 

operations automatically.  

A computer is an electronic device that manipulates information, or data. It has the ability to store, retrieve, 

and process data. You can use a computer to type documents, send email, and browse the Web. You can also 

use it to handle spreadsheets, accounting, database management, presentations, games, and more. 

In World War II, mechanical analog computers were used for specialized military applications. During this 

time the first electronic digital computers were developed. Computer was developed by CHARLES 

BABBAGE. He is also known as Father of computers. 

All types of computers consist of two basic parts: 

• Hardware is any part of your computer that has a physical structure (Tangible), such as the 

computer monitor or keyboard. 

 

• Software is any set of instructions that tells the hardware what to do. It is what guides the hardware 

and tells it how to accomplish each task. Some examples of software include web browsers, games, 

and word processors such as Microsoft Word. 

 

 

   

  

 

 

 

 

 

 

Organization of a Computer 

Computer can also be defined in terms of functions it can perform. A computer can 

i) Accept data,  

ii) Store data,  

iii) Process data as desired,  

iv) Retrieve the stored data as and when required and  
v) Print the result in desired format. 

 

Characteristics of computer:- 

• Speed 

• Accuracy 

• Power of 

Remembering 

• Diligence 

• Versatility 

• No IQ 

• No Feeling 

• Storage 

Output Unit          Processing Unit      INPUT

  

     Memory 
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Block diagram of Computer:- 

 

 
 

 

 

 

 

1. Input: this is the process of entering data and programs into the computer system. 

2. Control Unit (CU): The process of input, output, Control Unit (CU): The process of input, output, 

processing and storage is performed under the supervision of a unit called 'Control Unit'. It decides 

when to start receiving data, when to stop it, where to store data, etc. It takes care of step -by-step 

processing of all operations inside the computer. 

3. Memory Unit: Computer is used to store data and instructions. 

4. Arithmetic Logic Unit (ALU): The major operations performed by the ALU are addition, 

subtraction, multiplication, division, logic and comparison. 

5. Output: This is the process of producing results from the data for getting useful information. 

The ALU and the CU of a computer system are jointly known as the central processing unit (CPU). 

You may call CPU as the brain of any computer system. 

 

Basic application of Computer 

• Word Processing 

• Internet 

• Digital video or audio composition 

• Desktop publishing 

• Computers in Medicine 

• Mathematical Calculations 

• Banks 

• Travel 

• Telecommunications 

• Defense 

• E-Learning 

• Business 
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A motherboard is the main printed circuit board (PCB) found in general purpose microcomputers and other 

expandable systems. It holds and allows communication between many of the crucial electronic components 

of a system, such as the central processing unit (CPU) and memory, and provides connectors for 

other peripherals. A motherboard usually contains significant sub-systems such as the central processor, the 

chipset's input/output and memory controllers, interface connectors, and other components integrated for 

general purpose use. 

Motherboard specifically refers to a PCB with expansion capability and as the name suggests, this board is 

often referred to as the "mother" of all components attached to it, which often include peripherals, interface 

cards, and sound cards, video cards, network cards, hard drives, or other custom components. 

Computer Hardware: 

In simple terms we can say, computer parts that have tangible property are comes under computer hardware 

categories. Computer hardware is the physical parts or components of a computer.  This is also sometime 

called the machinery or the equipment of the computer. 

 

Computer Software:  

Computer software is instructions that can be stored and run by hardware. Software is any set of machine-

readable instructions that directs a computer's processor to perform specific operations.  

 

 

 

 

 

 

 

 

 

 

 

 

 

• Insurance 

• Banking 

• Business 

• Education 

• Marketing 

• Health Care 

• Engineering Design 

• Military 

• Communication 

• Government Applications 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The various applications of Computers:- 
 

Computer Software 

Hardware 

https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Microcomputer
https://en.wikipedia.org/wiki/Central_processing_unit
https://en.wikipedia.org/wiki/Computer_memory
https://en.wikipedia.org/wiki/Peripherals
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Peripheral
https://en.wikipedia.org/wiki/Sound_card
https://en.wikipedia.org/wiki/Video_card
https://en.wikipedia.org/wiki/Network_card
https://en.wikipedia.org/wiki/Hard_drive
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Input devices 

 

 
 

 

Input devices 
 
An input device is an electromechanical device as it utilizes both electronic and mechanical power. It aims in 

receiving data from external world. The input devices are responsible for converting data into a form that is 

understood by the computer. An input device is a peripheral device that converts symbols that people 

understand into bits that computers can process 

 

  

Basic working of input devices:- 

 

Computer Hardware 
- 
 

Input devices 
Output devices 
 

Storage device Processor 
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• Accept the data. 

• Convert it into the machine understandable form. 

 

Different Types of input devices:-  

 

• Keyboard 

• Mouse 

• Joystick 

• Light pen 

• Track Ball 

• Scanner 

• Graphic Tablet 

• Microphone 

• Magnetic Ink Card Reader (MICR) 

• Optical Character Reader (OCR) 

• Bar Code Reader 

• Optical Mark Reader 

 

 

 

Keyboard 

Keyboard is one of the most commonly used input devices to input the date into the computer. It is like the 

traditional typewriter, although there are some additional keys provided for performing some additional 

functions. Keyboards are of two sizes 84 keys or 101/102 keys, but now 104 keys or 108 keys. 

 

• Keyboard is an input device used to enter data in to computer by pressing one key at one time. 

• It has its own processor and circuitry that carries information to the processor. 

• When you press a key, it presses a switch, completing the circuit and allowing a tiny amount of 

current to flow through. 

• It tells the processor the position of each key what each keystroke or combination of keystrokes 

represents. 

 
• Despite the development of alternative input devices, such as mouse, touch screen, light pen, the 

keyboard remains the most commonly used and most versatile device used for direct (human) input 

into computers. 

• One factor determining the size of a keyboard is the presence of duplicate keys, such as a separate 

numeric keyboard, for convenience. 

•  Another factor determining the size of a keyboard is the size and spacing of the keys. 
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Generally, the keyboards contain the following keys, they are:- 

 Alphabets 

 Arithmetic operators such as +, -, *, / 

 Numeric digits 0–9 

 Cursor arrow keys 

 Navigation keys such as Home, End, PgUp, PgDown, etc. 

 Num Lock button, used to enable or disable the numeric pad.  

 Enter key 

 

The following are the different layouts of the keyboards, they are as follows 

 QWERTY 

 QWERTZ 

 AZERTY  

 DVORAK 

 

Mouse: 

The mouse is used to point to a particular place on the screen and select to perform one or more action. The 

pointing device may point to the menu, commands, size windows, starts programs etc. The most conventional 

kind of mouse has two buttons on top: the left one being used most frequently then right one. A mouse is a 

pointing device that functions by detecting 2D motion relative to its supporting surface. The mouse's motion 

typically translates into the motion of a pointer on a display, which allows for fine control of a graphical user 

interface 

 

Mouse Actions 

• Left Click  

• Double Click  

• Right Click  

• Drag and Drop 

 

Types of mouse:- 

 

• Mechanical mouse: Houses a hard rubber ball that rolls as the mouse is moved. Sensors inside the 

mouse body detect the movement and translate it into information that the computer interprets. 

• Optical mouse: Uses an LED sensor to detect tabletop movement and then sends off that information 

to the computer for merry munching. 

• Cordless 3-D mouse: This kind of mouse can be pointed at the computer screen like a TV remote 

• Wireless Mouse: Wireless mouse works via radio frequencies commonly referred to as RF. RF 

wireless mouse requires two components to work properly – a radio transmitter and a radio receiver. 

RF Transmitter: A radio frequency (RF) transmitter is usually integrated inside the mouse. The 

mouse records its movements and buttons that are clicked and then sends this information via radio 

signals to the receiver. 

RF Receiver: The radio frequency (RF) receiver usually connects to the computer’s peripheral mouse 

input. It receives these RF signals, decodes them, and then sends these signals directly to the computer 

as normal. 
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                 Mechanical Mouse     Wireless Mouse 

 

Track ball: 

This is also a pointing device. Track ball is an input device that is mostly used in notebook or laptop 

computer, instead of a mouse. This is a ball, which is half inserted and by 

moving fingers on ball, pointer can be moved. Since the whole device is not 

moved, a track ball requires less space than a mouse. A track ball comes in 

various shapes like a ball, a button and a square. 

 

Compared with a mouse, a trackball has no limits on effective travel; at 

times, a mouse can reach an edge of its working area while the operator still 

wishes to move the screen pointer farther. With a trackball, the operator just 

continues rolling, whereas a mouse would have to be lifted and re-

positioned. 

 

 

Joystick:- 

The joystick is handheld stick. This stick can rotate about one end transmitting its 

angle to the computer in two or three dimensions. It typically has a button on top 
that is used to select the option pointed by the cursor.  

Joysticks are often used to control video games, and usually have one or more 

push-buttons whose state can also be read by the computer. 
 

Elements in a Joystick 

• Stick  

• Base 

• Trigger 

• Extra button 

• Autofire 

switch 

• Throttle 

• Hat switch 

• Suction cup 
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Digitizing Tablet: 

An input device that permits drawing of images and graphics is called a digitizing tablet. They give feeling of 

drawing images with pencil and paper. The graphics tablet has two major parts that are:- 

• A flat surface on which the image is drawn. 

• Stylus that helps in drawing. 

 

 

Scanners 

An input device capable to read text or illustrations printed on a paper and 

interpret it in a form that can be used by a computer is known as a scanner. It 

converts the document image into digital form so that it can be fed into the 

computer. Capturing information like this reduces the possibility of errors 

typically experienced during large data entry. 

 

Digital Camera 

A digital camera can store many more pictures than an ordinary camera. Pictures taken using a digital camera 

are stored inside its memory and can be transferred to a computer by connecting the camera to it. A digital 

camera takes pictures by converting the light passing through the lens at the front into a digital image. 

There are several categories in which the cameras can be classified:- 

• Video camera  

➢ Professional video cameras 

➢ Camcorders used by amateurs. 

➢ webcams 

• Digital camera 

➢ Live-preview digital cameras 

➢ Compact digital cameras 

➢ Bridge cameras 

 

 

 

Magnetic Ink Character Recognition: 

 

 
MICR is also an input device is commonly used in banks because of a large number of cheques to be 

processed. The bank's code number and cheque number are printed on the cheques with a special type of ink 

that contains particles of magnetic material that are machine readable. This reading process is called Magnetic 

Ink Character Recognition (MICR).  
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Magnetic Ink Character Recognition is a character recognition system that uses special ink and characters. 

When a document that contains this ink needs to be read, it passes through a machine, which magnetizes the 

ink and then translates the magnetic information into characters. 

 

MICR technology is used by banks. Numbers and characters found on the bottom of checks (usually 

containing the check number, sort number, and account number) are printed using Magnetic Ink. To print 

Magnetic Ink need, you need a laser printer that accepts MICR toner. 

MICR provides a secure, high-speed method of scanning and processing information. 

 

Optical character Reader:- 

Optical character Reader is an input device that is use to read a printed text. The OCR scans text 

optically character by character, converts them into a computer readable code and stores the text 

on the system memory. 

 

Optical Mark Reader:- 

Optical mark reader is also known as optical mark recognition that is same as the scanner which reads on 

specific areas of the page. Thus, OMR can be defined as the process of scanning paper-based documents and 

identify data or marks in a location defined previously. 

It is specially used for checking the answer sheets of examinations having multiple choice questions. 

 

Bar Code Reader:- 

An electronic device used to read barcodes printed on various surfaces is called barcode 

reader. It is also known as barcode scanner. Bar Code Reader scans a bar code image, 

converts it into an alphanumeric value, which is then fed to the computer to which bar 

code reader is connected. 

Bar coded data is generally used in labeling goods, numbering the books, etc. It may be a 

hand-held scanner or may be embedded in a stationary scanner. 

 

 

 

Voice Recognition System:- 

Voice recognition systems are alternatively known as voice data entry or audio data entry terminals. This 

method of input enables a programmer to instruct the computer with spoken words instead of a written 

program 

 

 

Light Pen:- 

Light pen is also an input device used as pointing device, which 

is similar to a pen. It is used to select a displayed menu item or 

draw pictures on the monitor screen. It consists of a photocell 

and an optical system placed in a small tube. 

When light pen's tip is moved over the monitor screen and pen 

button is pressed, its photocell sensing element detects the 

screen location and sends the corresponding signal to the CPU. 

 A light pen is a computer input device used in 

conjunction with a computer's CRT display. 
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 It allows the user to point to displayed objects or draw on the screen in a similar way to 

a touch screen but with greater positional accuracy. 

 A light pen detects a change of brightness of nearby screen pixels when scanned by cathode 

ray tube electron beam and communicates the timing of this event to the computer. 

 Because the user is required to hold his arm in front of the screen for long period of time, the 

light pen fell out of use as a general-purpose input device. 

Touch screen:- 

An input device that permits users to operate a PC by simply touching the display screen is called a touch 

screen. The touch screen is as easy to use as trackballs or touchpads. 

Three major components form a basic touch screen they are as follows:- 

• Touch sensor 

• Controller 

• Software driver 
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An output is an electromechanical device that receives output from a computer in binary coded form and 

converts it into human understandable form and transmits to the user. An output device is any peripheral that 

receives data from a computer, usually for display, projection, or physical reproduction. 

• Monitor / Visual Display Unit 

• Printer 

• Plotter 

• Speaker 

 

Monitor: 

Monitor is the most common and the most popular output device.  It forms images from tiny dots, called 

pixels that are arranged in a rectangular form. The sharpness of the image depends upon the number of the 

pixels. 

 

There are two types of viewing screen used for monitors: 

 

• Cathode-Ray Tube (CRT):  

The CRT display is made up of small picture elements called pixels. The smaller the 

pixels, the better the image clarity, or resolution. It takes more than one illuminated pixel 

to form whole character, such as the letter ‘e’ in the word help. 

• There are some disadvantages of CRT: 

• Large in Size 

• High power consumption 

 

• Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have reduced volume, weight and power 

requirement in comparison to the CRT. You can hang them on walls or wear them on your wrists. Current 

uses of flat-panel displays include calculators, video games, monitors, laptop computer, graphics display. 

 

The flat-panel display is divided into two categories: 
• Emissive Displays - The emissive displays are devices that 

convert electrical energy into light. Example are plasma panel and 

LED(Light-Emitting Diodes). 

• Non-Emissive Displays - The Non-emissive displays use 

optical effects to convert sunlight or light from some other source 

into graphics patterns. Example is LCD(Liquid-Crystal Device) 

 

 

 

Classification- Based on Signals: 

• Digital Monitor 

• Analog Monitor 

 

 

 

 

Output devices: 
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Classification- Based on Picture Quality 

• VGA 

• SVGA 

• XGA 

 

Printer:- 

A printer is an output device that is used in a computer to print alphanumeric characters on papers. It converts 

the electronic signals from the computer into human readable form or hardcopy to produce a print out of the 

result of data processed in the computers. 

Printers are broadly classified in to two categories:- 

 

Impact printers: 

An impact printer has mechanisms resembling those of a typewriter. It forms characters or images by 

striking a mechanism such as a print hammer or wheel against an inked ribbon, leaving an image on 

paper. 

 

➢ Character Printer:-  

Impact printers are dying out; however, you may still come in contact with a dot-matrix printer. 

A dot-matrix printer contains a print head of small pins that strike an inked ribbon, forming 

characters or images. Print heads are available with 9, 18, or 24 pins; the 24-pin head offers the best print 

quality. 

➢ Dot-matrix printers permit a choice between output of draft quality; a coarser-looking 72 dots per 

inch vertically, which may be acceptable for drafts of papers and reports, and near-letter-quality, a 

crisper-looking 144 dots per inch vertically, which is more suitable for a finished product to be shown 

to other people. 

 

➢ Dot-matrix printers print about 40-300 characters per second (cps) and can print some graphics, 

although the reproduction quality is poor. Color ribbons are available for limited use of color. Dot-

matrix printers are noisy, inexpensive, and they can print through multipart forms, creating several 

copies of a page at the same time,  
 

 

✓ Dot-Matrix Printer 
✓ Daisy-Wheel Printer 

➢ Line printer 

✓ Drum Printer 

✓ Chain Printer 

• Non-Impact printers 

✓  Ink-Jet Printer 

✓   Laser Printer 

 

Plotter:- 

A plotter is a vector graphics printing device that connects to a computer. It draws pictures on paper based on 

commands from computer. A plotter is a very versatile tool. 
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Types of plotters:- 

• Drum plotter 

• Flat-Bed plotter 

 

Sound Cards:- 

Sound cards are an important part of computer, without sound cards you will have no music, no effects and no 

voices. Sound card is also referred as a sound board or an audio card, a sound card is an expansion 

card or integrated circuit that provides a computer with the ability to produce sounds that can be heard by the 
user either over speakers or headphones.  

Sound card connections are as follows:- 

• Digital out 

• Sound in or line in 

• Microphone or Mic 

• Sound out or line out 

• Fire wire 

• MIDI or Joystick 

 

Speakers:- 

 

 A hardware device that is connected to a computer's sound card that outputs sounds generated by the 

computer is referred as speaker. Speakers are rated in Frequency response, Total Harmonic Distortion, and 

Watts.  

 

Storage:- 

Computer data storage is often known as storage or memory refers to computer components and recording 

media that retain digital data used for computing for some interval of time. A memory is just like a human 

brain. It is used to store data and instructions. Computer memory is the storage space in computer where data 

is to be processed and instructions required for processing are stored. 

Memory is primarily of two types: 

• Primary Memory/Main Memory 

• Secondary Memory 

 

Primary memory:- 

Primary memory holds only those data and instructions on which computer is currently working. It has 

limited capacity and data gets lost when power is switched off. It is generally made up of semiconductor 

device. These memories are not as fast as registers. The data and instructions required to be processed earlier 
reside in main memory. Primary memory is divided into two categories they are as follows:- 

• RAM 

• ROM. 

 

 

 

RAM:- 

Full form of  RAM random access memory (RAM). A RAM constitutes the 

internal memory of the CPU for storing data, program and program result. It is 

read/write memory. Since access time in RAM is independent of the address to 

the word that is, each storage location inside the memory is as easy to reach as 

other location & takes the same amount of time 
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RAM is volatile, i.e., data stored in it is lost when we there is a power failure. Hence, a backup uninterruptible 

power system (UPS) is often used with computers. RAM is small, both in terms of its physical size and in the 

amount of data it can hold. 

There are two types of RAM they are as follows:- 

• Static RAM (SRAM) 

• Dynamic RAM (DRAM) 

 

Static RAM (SRAM) 

 

➢ The word static indicates that the memory retains its contents as long as power remains applied.  

➢ Data is lost when the power gets down due to volatile nature.  

➢ SRAM chips use a matrix of 6-transistors and no capacitors.  

➢ Transistors do not require power to prevent leakage, so SRAM need not have to be refreshed on a 

regular basis. 

➢ Because of the extra space in the matrix, SRAM uses more chips than DRAM for the same amount of 

storage space, thus making the manufacturing costs higher. 

➢ Static RAM is used as cache memory needs to be very fast and small. 

 

Characteristic of the Static RAM 

➢ It has long data lifetime 

➢ There is no need to refresh 

➢ Faster 

➢ Used as cache memory 

➢ Large size 

➢ Expensive 

➢ High power consumption 

 

Dynamic RAM (DRAM) 

➢ DRAM must be continually refreshed in order to maintain the data.  

➢ This is done by placing the memory on a refresh circuit that rewrites the data several hundred times 

per second. 

➢ DRAM is used for most system memory because it is cheap and small.  

➢ All DRAMs are made up of memory cells.  

➢ These cells are composed of one capacitor and one transistor. 

 

Characteristic of the Dynamic RAM 

➢ It has short data lifetime 

➢ Need to refresh continuously 

➢ Slower as compared to SRAM 

➢ Used as RAM 

➢ lesser in size 

➢ Less expensive 

➢ Less power consumption 

 

 

ROM:- 

ROM is Read Only Memory. ROM are the memories on which it is not 

possible to write the data when they are online to the computer. They can 

only be read. It is a permanent in built in the computer at the time of its 
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production. It is also known as firmware. It stores the set of instructions permanently which instructs the 

computer how to work. The ROM can be used in storing micro programs, system programs, subroutines. 

Types of ROM are as follows:- 

• PROM 

• EPROM 

• EEPROM 

 

MROM (Masked ROM) 

✓ The very first ROMs were hard-wired devices that contained a pre-programmed set of data or 

instructions.  

✓ These kinds of ROMs are known as masked ROMs.  

✓ It is inexpensive ROM. 

PROM (Programmable Read only Memory) 

✓ PROM is read-only memory that can be modified only once by a user.  

✓ The user buys a blank PROM and enters the desired contents using a PROM programmer.  

✓ Inside the PROM chip there are small fuses which are burnt open during programming.  

✓ It can be programmed only once . 

✓ It is not erasable. 

 

EPROM(Erasable and Programmable Read Only Memory) 

✓ The EPROM can be erased by exposing it to ultra-violet light for duration of up to 40 minutes.  

✓ During programming an electrical charge is trapped in an insulated gate region.  

✓ The charge is retained for more than ten years because the charge has no leakage path.  

✓ For erasing this charge, ultra-violet light is passed through a quartz crystal window (lid). 

✓ This exposure to ultra-violet light dissipates the charge.  

✓ During normal use the quartz lid is sealed with a sticker. 

 

EEPROM(Electrically Erasable and Programmable Read Only Memory) 

✓ The EEPROM is programmed and erased electrically.  

✓ It can be erased and reprogrammed about ten thousand times.  

✓ Both erasing and programming take about 4 to 10 ms (milli second).  

✓ In EEPROM, any location can be selectively erased and programmed. 

✓ EEPROMs can be erased one byte at a time, rather than erasing the entire chip. 

✓ Hence, the process of re-programming is flexible but slow. 

 

UVEPROM(Ultra Violet Erasable and Programmable Read Only Memory) 

✓ The UVEPROM is programmed and erased using ultra Violet rays.  

✓ It can be erased and reprogrammed about ten thousand times.  

✓ Both erasing and programming take about 4 to 10 ms (milli second).  

 

Advantages of ROM 

• Non-volatile in nature 

• These cannot be accidentally changed 

• Cheaper than RAMs 

• Easy to test 

• More Reliable than RAMs 

• These are static and do not require refreshing 

• Its contents are always known and can be verified 
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Secondary memory:- 

Secondary memory is also known as external memory or non-volatile. It is slower than primary memory. 

These are used for storing Data/Information permanently the data one stored will not be erased as the power is 

switched off. CPU directly does not access these memories, instead they are accessed via input-output 

routines. Contents of secondary memories are first transferred to main memory and then CPU can access it.  

Types of secondary memory are as follows:- 

• Magnetic tapes 

• Magnetic disk 
 

Magnetic tapes:- 

Magnetic tape is the most commonly used device for storing large data. It is sequential access device. 

Magnetic tape is a strip or ribbon of plastic which is coated with Ferro magnetic oxides. It is generally 80-

2400 feet long and ½ inch wide, in size. 

 

Magnetic Disk:- 

A magnetic disk is a circular plate constructed of metal or plastic coated with magnetized material. Both sides 

of the disk are used and several disks may be stacked on one spindle with read/write heads available on each 

surface. Bits are stored in magnetized surface in spots along concentric circles called tracks. Tracks are 

commonly divided into sections called sectors. Disk that are permanently attached and cannot removed by 

occasional user are called hard disks. A disk drive with removable disks is called a floppy disk drive. 

 

Types of magnetic disk:- 

• Hard disk 

• Floppy disk 

• Compact disk 

• Video CD 

• DVD 
 

Floppy Disk 

The floppy disk gets its name from the fact that it is made out of a flexible plastic material. The plastic base is 

coated with an iron-oxide recording substance that's similar to the material applied to the plastic ribbon of a 

magnetic tape. Data are recorded as tiny invisible magnetic spots on this coating.  

 

CD-ROM 

The CD-ROM (Compact Disk Read Only Memory) is a direct extension of audio CD. CD-ROM players are more 

rugged and have error correction facility. This ensures proper data transfer from CD-ROM to the RAM of the 

computer. CD-ROM is written using a CD writer. Information is retrieved from a CD-ROM using a low power 

laser, which ingenerate in an on optical disk drive unit.  

 

Hard Disk 

The disk described so far is the type of disks which can be removed from the disk drive and carried from place to 

place. Some disks however, are built into the computer or a special disk drive.. Hard disks can store anywhere from 

20 MB to more than 40GB. Hard disks are also from 10 to 100 times faster than floppy disk. 

 

USB drive (1) An external hard disk drive or optical disc drive that plugs into the USB port. portable hard drive. 

(2) A solid-state storage module that plugs into the computer's USB port. Using flash memory chips that hold up to 

one terabyte of data, the solid-state USB drive emulates a hard disk. 

A USB flash drive -- also known as a USB stick, USB thumb drive or pen drive -- is a plug-and-play portable 

storage device that uses flash memory and is lightweight enough to attach to a keychain. A USB flash drive can be 

used in place of a compact disc. 
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Cache Memory 

Cache memory is faster than the main memory. The cache memories although are fast yet are very expensive 

memories and are used in only small size. Thus, small cache memories are intended to provide fast speed of 

memory retrieval without sacrificing the size of memory. Cache memory stores a copy of the instructions and data 

to be immediately used of main memory. The memory reads or writes operation is first checked with cache 

memory and if the desired location data is available in cache memory then used by the CPU directly. 

 

 

Other Memories:- 

• Flash memory 

• Virtual memory 

• Cache Memory 

 

Software 

 

Software is a set of program which performs desired task. Software runs on hardware. Software is a sequence 

of instructions written to solve a particular problem. 

There are two types of software’s: 

• System Software 

• Application Software 

 

System Software:- 

System Software performs the basic functions necessary to start and operate a computer. It refers to all 

programs that make computer work. It controls and monitors the various resources of a computer such as 

processor, input-output devices and communication links. Example : - Operating System and Compiler  

 

System software is divided into three categories:- 

• System management software 

• System support software 

• System development software 

 

Application Software:- 

Application software refers to the programs which help the computer to work effectively for specific 
applications. Example Ms- Office , Tally , Adobe etc. 

Application software is of two types:- 

• General purpose program 

• Application specific program 

Other software’s are as follows:- 

 

 Utility software 

utility software are those software that is used for system utilization . 

like antivirus , window media player etc. 

 

Virus :-  

A computer virus is a program or piece of code that is loaded onto your computer without your knowledge 

and runs against your wishes. All computer virus are man-made. 

A few prominent virus are Michelangelo, dishwasher, C-brain , macmag , nenusalem , columbus  etc. 
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Antivirus : - a utility software that searches a hard disk for viruses and removes any that are found. Most 

antivirus programs include an auto update feature that enables the program to download profiles of nes virus 

so that it can check for the new viruses as soon as they are discovered. 

Some popular antivirus are NPAV, Quick heal ,Avast and Mac fee etc. 

 

Compiler - Compiler is a system program which translates a high-level language program into machine 

language program is called a compiler. Compiler also checks error of the program to be executed. 

 

Features of the compiler:  

Compiler is more powerful than assembler. 

 

Limitation of the compiler: 

• Take longer time to produce result. 

• It occupies more memory space. 

• Low speed and low efficiency of memory utilization. 

 

 
 

Interpreter - It is also a translator which translates a high-level language program into object code, statement 

wise. It doesn’t translate the entire program at a time. It takes up one statement of a high-level language 

program at a time, translates it and then executes it and then takes up the next statement and repeats the whole 

process till end. 

Features of the Interpreter: 

• Interpreter is cheaper than compiler. 

• It occupies less memory space. 
 

 

Limitations of the Interpreter: 

• Slower than compiler. 

• Suitable only for small programs. 
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The difference between an interpreter and a compiler is given below: 

Interpreter Compiler 

Translates program one statement at a time. 
Scans the entire program and translates it as a 

whole into machine code. 

It takes less amount of time to analyze the source 

code but the overall execution time is slower. 

It takes large amount of time to analyze the source 

code but the overall execution time is 

comparatively faster. 

No intermediate object code is generated, hence 

are memory efficient. 

Generates intermediate object code which further 

requires linking, hence requires more memory. 

Continues translating the program until the first 

error is met, in which case it stops. Hence 

debugging is easy. 

It generates the error message only after scanning 

the whole program. Hence debugging is 

comparatively hard. 

Programming language like Python, Ruby use 

interpreters. 
Programming language like C, C++ use compilers. 

 

Linker: In high level languages, some built in header files or libraries are stored. These libraries are 

predefined and these contain basic functions which are essential for executing the program. These functions 

are linked to the libraries by a program called Linker.  

If linker does not find a library of a function then it informs to compiler and then compiler generates an error. 

The compiler automatically invokes the linker as the last step in compiling a program. 
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Not built in libraries, it also links the user defined functions to the user defined libraries. Usually a longer 

program is divided into smaller subprograms called modules. And these modules must be combined to 

execute the program. The process of combining the modules is done by the linker. 

 

Loader: Loader is a program that loads machine codes of a program into the system memory. In Computing, 

a loader is the part of an Operating System that is responsible for loading programs. It is one of the essential 

stages in the process of starting a program. Because it places programs into memory and prepares them for 

execution. Loading a program involves reading the contents of executable file into memory.  Once loading is 

complete, the operating system starts the program by passing control to the loaded program code. All 

operating systems that support program loading have loaders. In many operating systems the loader is 

permanently resident in memory.  

 
 

 

Languages of Computer:- 

 

In order to communicate with the computer user also needs to have a language that should be understood by 

the computer. For this purpose, different languages are developed for performing different types of work on 

the computer. Basically, There are three types of computer languages they are as follows:- 

• Low level language 

• Assembly level language 

• High level language 

 

Low level language:- 

Low level language is also known as Machine level language. The low-level language is 

directly understood by the computer. in other words, the binary language is machine 

language(0s and 1s). any instruction given in the machine language has two parts:- 

• OPCODE 

• OPERAND 

 

Assembly level language:- 

The major drawback of machine language lead to the introduction of a new language 

called assembly level language. A program written in symbolic language is called an assembly code or a 
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symbolic program. Assembler translates the assembly code into machine code, it also “assembles” the 

machine code into the main memory of the computer and makes it ready for execution. 

 

High Level Language:- 

To overcome the difficulties of low-level language such as machine dependency, difficult to understand etc. 

high-level languages are classified into two types- general and specific purpose high level language. 

 

 

 

Data compression 

Data compression is encoding of information using fewer bits than the original representation. The process 

of reducing the size of a data file is referred to as data compression 

Lossy: Lossy compression reduces bits by removing unnecessary or less important information. 

Lossless: Lossless compression reduces bits by identifying and eliminating statistical redundancy. No 

information is lost in lossless compression. 

Uncompressing (or decompressing) is the act of expanding a compression file back into its original form.  It is 

the reverse process of compression. 

Compression is useful because it reduces resources required to store and transmit data. Data compression is 

subject to a space–time complexity trade-off. For instance, a compression scheme for video may require 

expensive hardware for the video to be decompressed fast enough to be viewed as it is being decompressed, 

and the option to decompress the video in full before watching it may be inconvenient or require additional 

storage.  
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Operating System 

An operating system is a program that acts as an interface between the user and the computer hardware and 

controls the execution of all kinds of programs. 

In technical terms, it is software which manages hardware. An operating System controls the allocation of 

resources and services such as memory, processors, devices and information. 

 
 

Functions of operating system 

Following are some of important functions of an operating System. 

• Memory Management 

• Processor Management 

• Device Management 

• File Management 

• Security 

• Control over system performance 

• Job accounting 

• Error detecting aids 

• Coordination between other software and users 

 

Memory Management 

Memory management refers to management of Primary Memory or Main Memory. Main memory is a large 

array of words or bytes where each word or byte has its own address.  

Main memory provides a fast storage that can be access directly by the CPU. So, for a program to be 

executed, it must in the main memory. Operating System does the following activities for memory 

management. 

• Keeps tracks of primary memory i.e. what part of it are in use by whom, what part are not in use. 

• In multiprogramming, OS decides which process will get memory when and how much. 

• Allocates the memory when the process requests it to do so. 

• De-allocates the memory when the process no longer needs it or has been terminated. 
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Process Management 

In multiprogramming environment, OS decides which process gets the processor when and how much time. 

This function is called process scheduling. Operating System does the following activities for processor 

management. 

• Keeps tracks of processor and status of process. Program responsible for this task is known as traffic 

controller. 

• Allocates the processor (CPU) to a process. 

• De-allocates processor when processor is no longer required. 

 

Device Management 

OS manages device communication via their respective drivers. Operating System does the following 

activities for device management. 

• Keeps tracks of all devices. Program responsible for this task is known as the I/O controller. 

• Decides which process gets the device when and for how much time. 

• Allocates the device in the efficient way. 

• De-allocates devices. 

 

File Management 

A file system is normally organized into directories for easy navigation and usage. These directories may 

contain files and other directions. Operating System does the following activities for file management. 

• Keeps track of information, location, uses, status etc. The collective facilities are often known as file 

system. 

• Decides who gets the resources. 

• Allocates the resources. 

• De-allocates the resources. 

 

Resource Allocation 

The resources such as CPU, memory, I/O channels are needed by all user jobs, and their allocation is handled 

automatically by the operating system. Some problems to be handled by the operating system are: 

- mutual exclusion 

- process synchronization,  

- deadlock avoidance 

- security and protection 

 

Other Important Activities 
Following are some of the important activities that Operating System does. 

• Security -- By means of password and similar other techniques, preventing unauthorized access to 

programs and data. 

• Control over system performance -- Recording delays between request for a service and response 

from the system. 

• Job accounting -- Keeping track of time and resources used by various jobs and users. 

• Error detecting aids -- Production of dumps, traces, error messages and other debugging and error 

detecting aids. 

• Coordination between other software’s and users -- Coordination and assignment of compilers, 

interpreters, assemblers and other software to the various users of the computer systems. 

CUI: character user interface or command-line user interface, CUI is a prompt used to interact with 

computer programs. It works by allowing the user (client) to issue commands as one or more lines of text 

(referred to as command lines) to a program. One of the CUI's uses is that it provides an easy way to 

implement programming scripts. 
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The command-line user interface was the primary method of communicating with a computer from the 

first machines, all the way through the 1980s. Although it may still be accessed in most of today 

operating systems, it is utilized far less due to the ease of use and familiarity of the graphical user 

interface (GUI). The CUI, however, is still preferred by many advanced end users as its features provide 

them with more comprehensive control over an operating system's functions. 

Good examples of command lines include MS-DOS, Windows command line, Terminal, and the Linux 

command line. 

GUI 

GUI is what most modern computers make use of. This is an interface that makes use of graphics, images 

and other visual clues such as icons. This interface made it possible for a mouse to be used with a 

computer and interaction really became very easy as the user could interact with just a click of the mouse 

rather than having to type every time to give commands to the computer. 

Modern operating systems use a graphical user interface, or GUI (pronounced gooey). A GUI lets you use 

your mouse to click icons, buttons, and menus, and everything is clearly displayed on the screen using a 

combination of graphics and text. 

Icons 

•Small pictures that represent commands, files, or windows. 
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Difference between CUI and GUI 

• CUI and GUI are user interface used in connection with computers 

• CUI is the precursor of GUI and stands for character user interface where user has to type on 

keyboard to proceed. On the other hand, GUI stands for Graphical User Interface which makes it 

possible to use a mouse instead of keyboard 

• GUI is much easier to navigate than CUI 

• There is only text in case of CUI whereas there are graphics and other visual clues in case of 

GUI 

• Most modern computers use GUI and not CUI 

• DOS is an example of CUI whereas Windows is an example of GUI. 

 

 

TYPES OF OPERATING SYSTEM 

 

The categories are: 

 

• Real-time operating system (RTOS) - Real-time operating systems are used to control machinery, 

scientific instruments and industrial systems. An RTOS typically has very little user-interface 

capability, and no end-user utilities, since the system will be a "sealed box" when delivered for use. A 

very important part of an RTOS is managing the resources of the computer so that a particular 

operation executes in precisely the same amount of time, every time it occurs. In a complex machine, 

having a part move more quickly just because system resources are available may be just as 

catastrophic as having it not move at all because the system is busy. 

• Single-user, single task - As the name implies, this operating system is designed to manage the 

computer so that one user can effectively do one thing at a time. The Palm OS for Palm handheld 

computers is a good example of a modern single-user, single-task operating system. 

• Single-user, multi-tasking - This is the type of operating system most people use on their desktop 

and laptop computers today. Microsoft's Windows and Apple's MacOS platforms are both examples 

of operating systems that will let a single user have several programs in operation at the same time. 

For example, it's entirely possible for a Windows user to be writing a note in a word processor while 

downloading a file from the Internet while printing the text of an e-mail message. 

• Multi-user - A multi-user operating system allows many different users to take advantage of the 

computer's resources simultaneously. The operating system must make sure that the requirements of 

the various users are balanced, and that each of the programs they are using has sufficient and 

separate resources so that a problem with one user doesn't affect the entire community of users. Unix, 

VMS and mainframe operating systems, such as MVS, are examples of multi-user operating systems. 

• Batch Processing- Batch processing is a technique in which an Operating System collects the 

programs and data together in a batch before processing starts. An operating system does the 
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following activities related to batch processing: • The OS defines a job which has predefined 

sequence of commands, programs and data as a single unit. • The OS keeps a number a jobs in 

memory and executes them without any manual information. • Jobs are processed in the order of 

submission, i.e., first come first served fashion. • When a job completes its execution, its memory is 

released and the output for the job gets copied into an output spool for later printing or processing. 

Advantages • Batch processing takes much of the work of the operator to the computer. • Increased 

performance as a new job gets started as soon as the previous job is finished, without any manual 

intervention. Disadvantages • Difficult to debug programs. • A job could enter an infinite loop. • Due 

to lack of protection scheme, one batch job can affect other pending jobs. 

 

 

 
Time-sharing Operating Systems 
Time-sharing is a technique which enables many people, located at various terminals, touse a particular 

computer system at the same time. Time-sharing or multitasking is a logical extension of 

multiprogramming. Processor's time which is shared among multiple users simultaneously is termed as 

time-sharing. 

 

The main difference between Multi-programmed Batch Systems and Time-Sharing Systems is that in case 

of Multi-programmed batch systems, the objective is to maximize processor use, whereas in Time-

Sharing Systems, the objective is to minimize response time. 

 
Multiple jobs are executed by the CPU by switching between them, but the switches occur so frequently. 

Thus, the user can receive an immediate response. For example, in a transaction processing, the processor 

executes each user program in a short burst or quantum of computation. That is, if n users are present, 

then each user can get a time quantum. When the user submits the command, the response time is in few 

seconds at most. 

 

The operating system uses CPU scheduling and multiprogramming to provide each user with a small 

portion of a time. Computer systems that were designed primarily as batch systems have been modified to 

time-sharing systems. 

Advantages of Timesharing operating systems are as follows: 

• Provides the advantage of quick response 

• Avoids duplication of software 

• Reduces CPU idle time 
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Multiprogramming 
Sharing the processor, when two or more programs reside in memory at the same time, 

is referred as multiprogramming. Multiprogramming assumes a single shared processor. 

Multiprogramming increases CPU utilization by organizing jobs so that the CPU always has 

one to execute. 

The following figure shows the memory layout for a multiprogramming system. 

 
 

An OS does the following activities related to multiprogramming. 

• The operating system keeps several jobs in memory at a time. 

• This set of jobs is a subset of the jobs kept in the job pool. 

• The operating system picks and begins to execute one of the jobs in the memory.  

Multiprogramming operating systems monitor the state of all active programs and 

system resources using memory management programs to ensures that the CPU 

is never idle, unless there are no jobs to process. 

 

Advantage 

• High and efficient CPU utilization. 

• User feels that many programs are allotted CPU almost simultaneously. 

Disadvantages 

• CPU scheduling is required. 

• To accommodate many jobs in memory, memory management is required. 

 

Multitasking 

Multitasking is when multiple jobs are executed by the CPU simultaneously by switching 

between them. Switches occur so frequently that the users may interact with each program 
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while it is running. An OS does the following activities related to multitasking: 

 
• The user gives instructions to the operating system or to a program directly, and receives an 

immediate response. 

• The OS handles multitasking in the way that it can handle multiple operations /executes 

multiple programs at a time. 

• Multitasking Operating Systems are also known as Time-sharing systems. 

• These Operating Systems were developed to provide interactive use of a computer system at 

a reasonable cost. 

• A time-shared operating system uses the concept of CPU scheduling and multiprogramming 

to provide each user with a small portion of a time-shared CPU. 

• Each user has at least one separate program in memory. 

• A program that is loaded into memory and is executing is commonly referred to as a process. 

• When a process executes, it typically executes for only a very short time before it either 

finishes or needs to perform I/O. 

• Since interactive I/O typically runs at slower speeds, it may take a long time to complete. 

During this time, a CPU can be utilized by another process. 

• The operating system allows the users to share the computer simultaneously. Since each 

action or command in a time-shared system tends to be short, only a little CPU time is 

needed for each user. 

• As the system switches CPU rapidly from one user/program to the next, each user is given 

the impression that he/she has his/her own CPU, whereas actually one CPU is being shared 

among many users. 

 

Real-Time Operating System 

 
A real-time system is defined as a data processing system in which the time interval required to process and 

respond to inputs is so small that it controls the environment. The time taken by the system to respond to an 

input and display of required updated information is termed as the response time. So, in this method, the 

response time is very less as compared to online processing. 
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Real-time systems are used when there are rigid time requirements on the operation of a processor or the flow 

of data and real-time systems can be used as a control device in a dedicated application. A real-time operating 

system must have well-defined, fixed time constraints, otherwise the system will fail. For example, Scientific 

experiments, medical imaging systems, industrial control systems, weapon systems, robots, air traffic control 

systems, etc. 

There are two types of real-time operating systems. 

 

Hard real-time systems 

Hard real-time systems guarantee that critical tasks complete on time. In hard real-time 

systems, secondary storage is limited or missing and the data is stored in ROM. In these 

systems, virtual memory is almost never found. 

 

Soft real-time systems 

Soft real-time systems are less restrictive. A critical real-time task gets priority over other 

tasks and retains the priority until it completes. Soft real-time systems have limited utility 

than hard real-time systems. For example, multimedia, virtual reality, Advanced Scientific 

Projects like undersea exploration and planetary rovers, etc. 

Distributed processing is a phrase used to refer to a variety of computer systems that use more than 

one computer (or processor) to run an application. This includes parallel processing in which a 

single computer uses more than one CPU to execute programs 

Distributed computing is a technique of distributing the information over number of devices. 

Devices may be computers or data terminals. Devices are interconnected with communication 

facilities. 

Microsoft Windows 

Microsoft created the Windows operating system in the mid-1980s. Over the years, there have been 

many different versions of Windows, but the most recent ones are Windows 10 (released in 2015), 

Windows 8 (2012), Windows 7 (2009), and Windows Vista (2007). Windows comes pre-loaded on 

most new PCs, which helps to make it the most popular operating system in the world. 

Mac OS X 

Mac OS is a line of operating systems created by Apple. It comes preloaded on all new Macintosh 

computers, or Macs. All of the recent versions are known as OS X (pronounced O-S Ten), and the 

specific versions include El Capitan (released in 2015), Yosemite (2014), Mavericks (2013), 

Mountain Lion (2012), and Lion (2011). 

Linux 

Linux  is a family of open-source operating systems, which means they can be modified and 

distributed by anyone around the world. This is different from proprietary software like Windows, 
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which can only be modified by the company that owns it. The advantages of Linux are that it is free, 

and there are many different distributions—or versions—you can choose from. 

Different distributions of Linux 

• Ubuntu,  

• Linux Mint 

• Fedora  

Operating systems for mobile devices 

The operating systems we've been talking about so far were designed to run on desktop and laptop 

computers. Mobile devices such as phones, tablet computers, and MP3 players are different from 

desktop and laptop computers, so they run operating systems that are designed specifically for 

mobile devices. Examples of mobile operating systems include  

• Apple iOS 

• Google Android 

Disk Defragmenter is a utility in Microsoft Windows designed to increase access speed by 

rearranging files stored on a disk to occupy contiguous storage locations, a technique called 

defragmentation. 

Disk Cleaning is a computer maintenance utility included in Microsoft Windows designed to free up 

disk space on a computer's hard drive. The utility first searches and analyzes the hard drive for files 

that are no longer of any use, and then removes the unnecessary files. There are a number of 

different file categories that Disk Cleanup targets when performing the initial disk analysis: 

• Compression of old files 

• Temporary Internet files 

• Temporary Windows files 

• Downloaded program files 

• Recycle Bin 

• Removal of unused applications or optional Windows components 

• Offline web pages (cached) 

MS Windows 

Windows XP is a personal computer operating system produced by Microsoft as part of the Windows 

NT family of operating systems. The operating system was released to manufacturing on August 24, 2001, 

and generally released for retail sale on October 25, 2001. 
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Windows XP is a graphical user interface (GUI). It has pictures (graphical) that you use (user) to 

communicate (interface) with the computer. This type of system is popular because it's logical, fun, and easy 

to use. 

This operating system has multi-tasking capabilities, meaning it can run several applications at the same time. 

Multi-tasking allows you to view this lesson on the Internet at the same time you practice using other 

applications with Windows XP. 

History of Windows: 

 

Versions Year 

Windows 10 Nov.1983 

Windows 1.0 Nov.1985 

Windows 2.0 09 Dec.1987 

Windows 3.0 22 May.1990 

Windows 95 August 1995 

Windows 98 June 1998 

Windows 2000 Feb.2000 

Windows XP 25 Oct. 2001 

Windows  Vista 2007 

Windows 7 22 July 2009 

Windows 8 26 Oct. 2012 

 

The New and updated features in the new program are: 

• Windows XP is faster, smarter, safer 

• Windows XP is easier to learn and use 

• Windows XP offers better help for every 

task 

• Playing music, video and CDs 

• Offers wizard 

• User interface 

• Infrastructure 

• Networking and internet functionality 

 

Windows XP editions 

• Home and Professional 

• Starter Edition 

• Media Center Edition 

• Tablet PC Edition 

• Subscription and pre-paid editions 

• 64-bit editions 

• Editions for embedded systems 

 

Windows XP is an operating system 

 Windows XP is a collection of programs, which enables the entire pc to work. Among Windows’ most 

important tasks are: 

• Assist in starting the pc. 

• Control and handling of all hardware, including RAM, I/O, cards and controllers. 

• Read-in of a graphics user interface with windows, menu bars etc. 

• Forms a platform for the user programs (applications) like Word, Internet Explorer, and Photoshop 

etc. 
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• Handling of user data in files. 

 

Beyond the pure operating system tasks Windows XP includes a large collection of smaller and larger tools. 

Among others Windows XP comes with Internet Explorer and the multimedia player Windows Media Player, 

which are independent user programs. 

 
 

Windows XP is both an operating system and a program package. 

 

Desktop 

Desktops in a Windows is utility that allows users to manage applications on up to four virtual desktops, all 

accessible using the tray icon interface. 4. When referring to an operating system or GUI, the Desktop is a 

system of organization of icons on a screen. The Microsoft Windows Desktop was first introduced with 

Microsoft Windows 95 and has been included with every version of Windows since then. 
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The desktop contains: 

• Start button: This is one of the most important tools you will use while working with Windows XP. 

The Start button allows you to open menus and start applications. 

• Taskbar: This is primarily used to switch between open windows and applications. Learn more about 

using the taskbar in a later lesson. 

• Icons (or graphical pictures): This represents applications, files, and other parts of the operating 

system. By default, Windows XP provides you with one desktop icon, the Recycle Bin.  

• Windows Notification Area 

• Time and Date: The date and time is also shown on the Desktop, in the notification area on the 

taskbar. If the date and time is incorrect, you can change the date and time right from the Desktop. 

 

Exploring Windows Explorer 

Windows Explorer is a file management tool that lets you create, rename, and delete folders. It also allows 

you to copy, print, move, delete, rename, and manage files. 

To open Windows Explorer: 

1. Open My Documents. 

2. Click the Folders button on the Navigation toolbar. 

3. A list of folders opens in the left pane. 

To explore Windows Explorer: 

1. With Windows Explorer open, scroll until you see the Control Panel icon in the left pane. 
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2. Click the Control Panel icon. The contents (of the Control Panel folder) display in the right pane. 

3. Practice viewing other folders in the list. 

4. To close Windows Explorer, click the small black X in the upper right of the list OR click 

the Folder button. 

 

The Taskbar 

The taskbar is the small blue bar you see at the bottom of your desktop. It contains the Start menu and 

the Quick Launch bar, which contains icons for Internet Explorer, Windows Media Player, and Show 

Desktop. Click an icon to open a program. Click Show Desktop to quickly view your desktop without closing 

any programs or windows. 

 
 

The box on the right is called the Notification Area. Microsoft also uses the Notification Area to remind you 

when software updates are available for download. 

 
 

When you open or minimize a window or program, a rectangular button appears on the taskbar that shows 

the name of the application.  

 

The Start menu 

When you click the Start button, the Start menu appears. The Start menu is your path to the applications on 

your computer. It contains two columns. The left side of the Start menu lists programs, while the right side 

allows access to common Windows folders (My Documents, for example). It also provides access to Help 

and Support, Search, and Run. If you select All Programs, a pop-up menu appears. Pop-up menus like this 

are called cascading menus. If a cascading menu is available, a small black triangle appears next to the 

name of the application or function. 

To explore the Start menu: 

1. Click the Start button. 

2. Move the mouse pointer to each option, and view the various cascading menus. 

3. Click (or roll your mouse pointer over) All Programs. 

4. Move the mouse pointer to the right, and view other cascading menus. 

5. To exit the menus, click outside the menu area or press Esc on your keyboard. 
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The Recycle Bin 

The Recycle Bin is nothing more than a space on the hard disk reserved to store information that is deleted so 

that in the event of deleting a file or folder by mistake it is possible to retrieve it. By default, the Recycle Bin 

restores files or folders to the place from where they were deleted. If, for example, a file is deleted 

from D:\my documents, when it is restored it will go to that folder. 

The Recycle Bin will maintain the deleted documents until it is emptied. 

To open the Recycle Bin place the cursor on Desktop and double-click on the Recycle Bin icon.  
 

Restoring Files or Folders 

To restore all of the elements from the Recycle Bin click on the green arrow on the left side that says restore 

all items. 

 

If we only want to restore some of the elements: 

1) Select the elements to be restored by clicking on them. If the elements are not in subsequent order, use 

the Ctrl key to select them or the Shift key if they are one below the other. 

2) Once selected, a dialog box will appear on the green arrow on the left that will say Restore this 

item or Restore the selected items. 

The selected files will return to where they were located before deletion. 

 

Deleting Files or Folders from the Recycle Bin 

Before deleting any element from the Recycle Bin you need to realize that once it is deleted it cannot be 

retrieved or restored. 



 
BBA-LLB III Sem.      Subject- Fundamentals of Computer  
 
 
 

 

 
37 

 

 If you want to delete any file or folder from the Recycle Bin follow these steps: 

1) Select the Elements to be deleted. 

2) Click on ; this will delete the selected elements. You can also do this by pressing the Delete button. 

The selected files will disappear and cannot be restored. 

 

My Computer 

Itis another tool you can use to manage files and folders. With this tool, you can create, rename 

and move folders and copy, print, move, delete and rename files. It also allows you to gain access to other 

system tools. 

To open My Computer: 

1. Double-click the My Computer icon on the desktop. 

2. My Computer opens. 

 

My Network Places overview 

My Network Places displays shortcuts to shared computers, printers, and other resources on the network. The 

shortcuts are created automatically in My Network Places whenever you open a shared network resource, 

such as a printer or shared folder. 

 

Open My Network Places 

• To open My Network Places, click Start, and then click My Computer. Under Other Places, click My 

Network Places.  

• The View workgroup computers task is displayed in My Network Places when your computer is in a 

workgroup and not in a domain. Double-click this icon to narrow your search to only those 

computers, printers, and resources that share a workgroup with your computer.  

• If your computer is connected to a workgroup that has less than 32 computers, Windows will 

automatically create shortcuts in My Network Places to the shared resources in your workgroup.  

• To add a shortcut in My Network Places to a folder on a Web server, the Web server must support 

network places.. 

 

My Documents 

The My Documents folder is your own personal folder in which you can store your documents, graphics, and 

other personal files. You can change the target if you want My Documents to point to a different folder 

location.  

• Change the Default Location of the My Documents Folder 

• To change the default location of the My Documents folder, follow these steps:  

• Click Start, and then point to My Documents.  

• Right-click My Documents and then click Properties. Click the Target tab.  

 

User Accounts 

To get at the settings for the User Accounts, click Start and then Control Panel. From the Control Panel, 

double click User Accounts.  

• We can create a new user account. 

• We can make the account as password protected. 

• Through admin we can even change the password. 

 

Windows XP Accessories Applications:  

• Calculator,  

• Notepad,  

• WordPad,  

• Paint  
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1. Using Windows XP Calculator 

Like a calculator you keep in a desk drawer, the Windows Calculator is small but saves you time by 

performing all the calculations common to a standard 

calculator. 

The Standard Windows Calculator works so much like a 

pocket calculator that you need little help getting started. 

To display the Calculator, open the Start menu and choose 

Programs, Accessories, Calculator. The Calculator opens in 

the same view (Standard or Scientific) in which it was 

displayed the last time it was used. 

 To close the Calculator, click the Close button in the title 

bar. If you use the Calculator frequently, however, don't close 

it; click the Minimize button to minimize the Calculator to a 

button on the taskbar. 

The Calculator has only three menus: Edit, View, and Help. 

The Edit menu contains two simple commands for copying 

and pasting; the View menu switches between the Standard 

and Scientific views; and the Help menu is the same as in all 

Windows accessories. 

 

 

 

 

2.   Using Windows XP Notepad 

Notepad is a miniature text after the 

calculations are performed. To enter 

numbers from the editor.  Just as you use a 

notepad on your desk, you can use Notepad 

to take notes onscreen while working in 

other Windows applications. 

 

Because Notepad stores files in text format, 
almost all word processing applications can 

retrieve Notepad's files. However, if you 

want the capability of formatting your 
documents, you'll need a true word processor. 

 

Starting Notepad 

To start Notepad, open the Start menu and choose Programs, Accessories, Notepad. Notepad starts up and 

displays a blank document in the Notepad window . 

 

Working with Documents in Notepad 

You can move the insertion point by using either the mouse or the keyboard. You select and edit text in 

Notepad the same way you select and edit text in WordPad. 



 
BBA-LLB III Sem.      Subject- Fundamentals of Computer  
 
 
 

 

 
39 

 

Limited formatting is available from the File, Page Setup command. You can change margins and add a 

header or footer, but you cannot format characters or paragraphs in any way. You also can use the Tab, 

Spacebar, and Backspace keys to align text. Tab stops are preset at every eight characters. 

 

With the commands on Notepad's Edit menu, you can cut, copy, and move text from one place in a file to 

another. Text that you cut or copy is stored in the Clipboard. When you paste text, the contents of the 

Clipboard are copied from the Clipboard to the document at the location of the insertion point. 

 

 

3. Using Windows XP WordPad 

 

Word Pad is the word processor that comes 

with Windows XP that can perform most basic 

word processing tasks. Although it is not 

nearly as powerful and versatile as a full-

featured word processing application (such as 

Microsoft Word XP), it is much more powerful 

than Notepad, the text editor that comes with 

Windows XP. 

 

Creating a New Document in WordPad 

WordPad is located in the Accessories 

submenu of the Start menu. To start WordPad, 

open the Start menu and choose Programs, 

Accessories, WordPad. The WordPad window appears. When you first open WordPad, you are presented 

with a blank document. 

 

 

4.Using Windows XP Paint 

Paint is an easy-to-learn graphics application that 

you can use to create and modify graphics images. 

 
Steps for starting Windows Paint 

To start Paint, click Start, Programs, Accessories, 

Paint. Paint starts up and opens a new, empty Paint 
file 

 

5.Using Windows XP Entertainment 

 Windows XP includes entertainment programs for 

playing CDs, viewing multimedia files, and 

recording and playing back sounds.  

It is capable of performing many tasks like: 

1. Playing Games 

2. Changing the Volume 

3. Playing a Sound with Sound Recorder 
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4. Playing an Audio CD 

5. Working with Media Player Controls 

6. Changing the Visualizations 

7. Copying CD Tracks 

8. Using the Media Library 

9. Creating a Playlist 

10. Tuning into the Radio 

11. Changing the Skin for Windows Media Player 

12. Playing a Video Clip 

13. Importing a Movie with Windows Movie Maker 

 

6. Using Windows XP Address Book 

 
 

The Address Book provides a convenient place to store contact information for easy retrieval from 

programs such as Outlook, Outlook Express, Internet Explorer, NetMeeting, and Microsoft Phone System. 

You can search for people and businesses, create groups of contacts for mailing lists, and send and receive 

electronic business cards. 

• Start Click All Programs, Accessories, Address Book 

Address Book Window will appear. 

 

Functions of address book as follows: 

• Create a new entry 

• Delete the existing entry 

• Edit the existing entry and etc. 

 

 

 

 

 



 
BBA-LLB III Sem.      Subject- Fundamentals of Computer  
 
 
 

 

 
41 

 

Changing Mouse Pointer 

1. Open Mouse Properties by clicking the Start button The Start button, and then clicking Control 

Panel. In the search box, type mouse, and then click Mouse. 

2. Click the Pointers tab, and then do one of the following:        

• To give all of your pointers a new look, click the Scheme drop-down list, and then click a new 

mouse pointer scheme. 

• To change an individual pointer, under Customize, click the pointer you want to change in the 

list, click Browse, click the pointer you want to use, and then click Open. 

3. Click OK. 

To change your desktop background 

1. Open Display in Control Panel. 

To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display.  

2. On the Desktop tab, do one or more of the following: 

• 
Click a picture in the Background list. In Position, click Center, Tile, or Stretch. 

• Click Browse to search for a background picture in other folders or on other drives. You can use files 

with the following extensions: .bmp, .gif, .jpg, .dib, .png, .htm. In Position, click Center, Tile, 

or Stretch. 

• 
Select a color from Desktop color. The color fills the space not used by a picture. 

 

Note 

• To open Display, click Start, click Control Panel, click Appearance and Themes, and then 

click Display.  

• You can use a personal picture as a background. All of your personal pictures located in My Pictures are 

listed by name in the Background list. 

• You can save a picture from a Web site as a background. Right-click the picture and then click Set as 

Background. The picture is listed in the Background box as Internet Explorer Background. 

• If you choose an .htm document as your background picture, the Position options are unavailable. The 

.htm document is automatically stretched to fill your background. 

 

Copying and Moving Files and Folders 

Sometimes you will need to move a file from one folder to another, or copy a file from one folder to 

another, leaving the file in the first location and placing a copy of it in the second. You can move or copy a 

file or folder using a variety of methods. If the file or folder and the location where you want to move it are 

visible in a window or on the desktop, you can simply drag the item from one location to the other. Moving 

a file or folder on the same disk relocates it whereas dragging it from one disk to another copies it so that it 

appears in both locations. When the destination folder or drive is not visible, you can use the Cut (to move), 

Copy, and Paste commands on the Edit menu to move or copy the items. 
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Copy a File or Folder 
1.  Open the drive or folder containing the file or folder you want to copy. 

2.  Select the files or folders you want to copy. 

 

 

Move a File or Folder 
1.  Open the drive or folder containing the file or folder you want to move. 

2.  Select the files or folders you want to move. 
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3. Click the Organize button on the toolbar, and then click Cut. 

4.  Display the destination folder where you want to move the files or folder. 

5.  Click the Organize button on the toolbar, and then click Paste. 

 

Copy or Move a File or Folder Using Drag and Drop 
1.  Open the drive or folder containing the file or folder you want to copy or move.  

2.  Select the files or folders you want to copy or move. 
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3. In the Navigation pane, point to a folder list to display the expand and collapse arrows. 

4.  Click the arrows to display the destination folder, and then click the destination folder. 

5.  Right-click the selected files or folders, drag to the destination folder, and then click Copy Here or Move Here. 

 

 

OLE (Object Linking and Embedding) 

Stands for "Object Linking and Embedding." OLE is a framework developed by Microsoft (way back in 

Windows 3.1) that allows you to take objects from a document in one application and place them in 
another. For example, OLE may allow you to move an image from a photo-editing program into a word 

processing document. 

The OLE technology was initially created to allow the linking of objects between "compound documents," 

or documents that support multiple types of data. Microsoft has since developed OLE into a wider standard, 

known as the Component Object Model (COM). COM is supported by Mac, Unix, and Windows systems, 

but is primarily used with Microsoft Windows. The COM framework is the foundation of ActiveX, which 

allows developers to create interactive content for the Web 

OLE (Object Linking and Embedding) is Microsoft's framework for a compound document technology. 

Briefly, a compound document is something like a display desktop that can contain visual and information 

objects of all kinds: text, calendars, animations, sound, motion video, 3-D, continually updated news, 

controls, and so forth. Each desktop object is an independent program entity that can interact with a user 

and also communicate with other objects on the desktop. Part of Microsoft's ActiveX technologies, OLE 
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takes advantage and is part of a larger, more general concept, the Component Object Model (COM) and its 

distributed version, DCOM. An OLE object is necessarily also a component (or COM object).OLE contains 

about 660 new function calls or individual program interfaces in addition to those already in Win32. 
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NUMBER SYSTEM 
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The technique to represent and work with numbers is called number system. Decimal number system is 

the most common number system. Other popular number systems include binary number system, octal 

number system, hexadecimal number system, etc. 

Decimal Number System 

Decimal number system is a base 10 number system having 10 digits from 0 to 9. This means that any 

numerical quantity can be represented using these 10 digits. Decimal number system is also a positional 

value system. This means that the value of digits will depend on its position. Let us take an example to 

understand this. 

Say we have three numbers – 734, 971 and 207. The value of 7 in all three numbers is different− 

• In 734, value of 7 is 7 hundreds or 700 or 7 × 100 or 7 × 102 

• In 971, value of 7 is 7 tens or 70 or 7 × 10 or 7 × 101 

• In 207, value 0f 7 is 7 units or 7 or 7 × 1 or 7 × 100 

The weightage of each position can be represented as follows − 

 

In digital systems, instructions are given through electric signals; variation is done by varying the voltage of 

the signal. Having 10 different voltages to implement decimal number system in digital equipment is 

difficult. So, many number systems that are easier to implement digitally have been developed. Let’s look at 

them in detail. 

Binary Number System 

The easiest way to vary instructions through electric signals is two-state system – on and off. On is 

represented as 1 and off as 0, though 0 is not actually no signal but signal at a lower voltage. The number 

system having just these two digits – 0 and 1 – is called binary number system. 

Each binary digit is also called a bit. Binary number system is also positional value system, where each 

digit has a value expressed in powers of 2, as displayed here. 
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In any binary number, the rightmost digit is called least significant bit (LSB) and leftmost digit is 

called most significant bit (MSB). 

 

And decimal equivalent of this number is sum of product of each digit with its positional value. 

110102 = 1×24 + 1×23 + 0×22 + 1×21 + 0×20 

= 16 + 8 + 0 + 2 + 0 

= 2610 

Computer memory is measured in terms of how many bits it can store. Here is a chart for memory capacity 

conversion. 

• 1 byte (B) = 8 bits 

• 1 Kilobytes (KB) = 1024 bytes 

• 1 Megabyte (MB) = 1024 KB 

• 1 Gigabyte (GB) = 1024 MB 

• 1 Terabyte (TB) = 1024 GB 

• 1 Exabyte (EB) = 1024 PB 

• 1 Zettabyte = 1024 EB 

• 1 Yottabyte (YB) = 1024 ZB 
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Octal Number System 

Octal number system has eight digits – 0, 1, 2, 3, 4, 5, 6 and 7. Octal number system is also a positional 

value system with where each digit has its value expressed in powers of 8, as shown here − 

 

Decimal equivalent of any octal number is sum of product of each digit with its positional value. 

7268 = 7×82 + 2×81 + 6×80 

= 448 + 16 + 6 

= 47010 

Hexadecimal Number System 

Octal number system has 16 symbols – 0 to 9 and A to F where A is equal to 10, B is equal to 11 and so 

on till F. Hexadecimal number system is also a positional value system with where each digit has its value 

expressed in powers of 16, as shown here − 

 

Decimal equivalent of any hexadecimal number is sum of product of each digit with its positional value. 

27FB16 = 2×163 + 7×162 + 15×161 + 10×160 

= 8192 + 1792 + 240 +10 

= 1023410 

Number System Relationship 

The following table depicts the relationship between decimal, binary, octal and hexadecimal number 

systems. 
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HEXADECIMAL DECIMAL OCTAL BINARY 

0 0 0 0000 

1 1 1 0001 

2 2 2 0010 

3 3 3 0011 

4 4 4 0100 

5 5 5 0101 

6 6 6 0110 

7 7 7 0111 

8 8 10 1000 

9 9 11 1001 

A 10 12 1010 

B 11 13 1011 

C 12 14 1100 

D 13 15 1101 
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E 14 16 1110 

F 15 17 1111 
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MS Words 

Microsoft Office Word 2010 allows you to create and edit personal and business documents, such as letters, 

reports, invoices, emails and books. By default, documents saved in Word 2010 are saved with the .docx 

extension. Microsoft Word can be used for the following purposes − 

• To create business documents having various graphics including pictures, charts, and diagrams. 

• To store and reuse readymade content and formatted elements such as cover pages and sidebars. 

• To create letters and letterheads for personal and business purpose. 

• To design different documents such as resumes or invitation cards etc. 

• To create a range of correspondence from a simple office memo to legal copies and reference 

documents. 

In this chapter, we will understand how to explore Window in Word 2010. Following is the basic window 

which you get when you start the Word application. Let us understand the various important parts of this 

window.. 
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File Tab 

The File tab replaces the Office button from Word 2007. You can click it to check the Backstage view. 

This is where you come when you need to open or save files, create new documents, print a document, and 

do other file-related operations. 
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Quick Access Toolbar 

This you will find just above the File tab. This is a convenient resting place for the mostfrequently used 

commands in Word. You can customize this toolbar based on your comfort. 

Ribbon 

 

Ribbon contains commands organized in three components − 

• Tabs − These appear across the top of the Ribbon and contain groups of related commands. Home, 

Insert, Page Layout are examples of ribbon tabs. 

• Groups − They organize related commands; each group name appears below the group on the 

Ribbon. For example, group of commands related to fonts or group of commands related to 

alignment, etc. 

• Commands − Commands appear within each group as mentioned above. 

Title bar 

This lies in the middle and at the top of the window. Title bar shows the program and document titles. 

Rulers 

Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal ruler appears just beneath the 

Ribbon and is used to set margins and tab stops. The vertical ruler appears on the left edge of the Word 

window and is used to gauge the vertical position of elements on the page. 

Help 

The Help Icon can be used to get word related help anytime you like. This provides nice tutorial on various 

subjects related to word. 
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Zoom Control 

Zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that you 

can slide left or right to zoom in or out; you can click the + buttons to increase or decrease the zoom factor. 

View Buttons 

The group of five buttons located to the left of the Zoom control, near the bottom of the screen, lets you 

switch through the Word's various document views. 

• Print Layout view − This displays pages exactly as they will appear when printed. 

• Full Screen Reading view − This gives a full screen view of the document. 

• Web Layout view − This shows how a document appears when viewed by a Web browser, such as 

Internet Explorer. 

• Outline view − This lets you work with outlines established using Word’s standard heading styles. 

• Draft view − This formats text as it appears on the printed page with a few exceptions. For 

example, headers and footers aren't shown. Most people prefer this mode. 

Document Area 

This is the area where you type. The flashing vertical bar is called the insertion point and it represents the 

location where text will appear when you type. 

Status Bar 

This displays the document information as well as the insertion point location. From left to right, this bar 

contains the total number of pages and words in the document, language, etc. 

You can configure the status bar by right-clicking anywhere on it and by selecting or deselecting options 

from the provided list. 

Dialog Box Launcher 

This appears as very small arrow in the lower-right corner of many groups on the Ribbon. Clicking this 

button opens a dialog box or task pane that provides more options about the group. 
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Let us see how easy it is to enter text in a Word document. We assume you know that when you start Word, 

it displays a new document by default as shown below − 

 

Document area is the area where you type your text. The flashing vertical bar is called the insertion point 

and it represents the location where the text will appear when you type. keep the cursor at the text insertion 

point and start typing the text. We typed only two words "Hello Word" as shown below. The text appears to 

the left of the insertion point as you type − 
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The following are the two important points that will help you while typing − 

• You do not need to press Enter to start a new line. As the insertion point reaches the end of the line, 

Word automatically starts a new one. You will need to press Enter, to add a new paragraph. 

• When you want to add more than one space between words, use the Tab key instead of the 

spacebar. This way you can properly align text by using the proportional fonts. 
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we will discuss how to save a document in Word 2010. 

Saving New Document 

Once you are done with typing in your new Word document, it is time to save your document to avoid 

losing work you have done on a Word document. Following are the steps to save an edited Word document 

− 

Step 1 − Click the File tab and select the Save As option. 
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Step 2 − Select a folder where you will like to save the document, Enter the file name which you want to 

give to your document and Select the Save Asoption, by default it is the .docx format. 

 

Step 3 − Finally, click on the Save button and your document will be saved with the entered name in the 

selected folder. 
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Saving New Changes 

There may be an instance when you open an existing document and edit it partially or completely, or an 

instance where you may like to save the changes in between editing of the document. If you want to save 

this document with the same name, then you can use either of the following simple options − 

• Just press the Ctrl + S keys to save the changes. 

• Optionally you can click on the floppy icon available at the top left corner and just above the File 

tab. This option will also help you save the changes. 

• You can also use the third method to save the changes, which is the Save option available just 

above the Save As option as shown in the above screenshot. 

If your document is new and it was never saved so far, then with either of the three options, Word will 

display a dialogue box to let you select a folder, and enter the document name as explained in case of saving 

new document. 

Insert and Add Text 

First we will see how inserted text will be added into the existing content without replacing any existing 

content. 

Step 1 − Click the location where you wish to insert text; you can also use the keyboard arrows to locate the 

place where the text needs to be inserted. 
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Step 2 − Start typing the text that needs to be inserted. Word inserts the text to the left of the insertion point, 

moving the existing text to the right 
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Insert and Replace Text 

In the Insertion mode, text will be added into the existing content but same time it will over write all the 

content which comes in its way. 

Step 1 − Right-click the status bar and select the Overtype option from the displayed menu. 



 
BBA-LLB III Sem.      Subject- Fundamentals of Computer  
 
 
 

 

 
76 

 

 

When you select the Overtype option, the status bar will show the insertmode as shown below − 
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Step 2 − Click on the Insert text available at the status bar and it will switch to the Overtype mode as 

shown below − 
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Step 3 − Now click the location where the text needs to be inserted or you can use the keyboard arrows to 

locate the place where the text needs to be inserted. 
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Step 4 − Start typing the text that needs to be inserted. Word will replace the existing text with the newly 

typed text without moving the position of the exiting test. 
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Note − Microsoft Word 2010 disabled the functionality of the Insert key and it does nothing, so you will 

have to follow-up with the above mentioned procedure to turn-on or turn-off the Insert mode. 

Using Backspace & Delete Keys 

The most basic deletion technique is to delete characters one at a time by pressing either the backspace key 

or the delete key. Following table describes how you can delete single character or a whole word by using 

either of these two keys − 

S.No Keys & Deletion Methods 

1 
Backspace 

Keep the insertion point just after the character you want to delete and press 
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the Backspace key. Word deletes the character immediately to the left of the insertion 

point. 

2 

Ctrl + Backspace 

Keep the insertion point just after the word you want to delete and press Ctrl + 

Backspace key. Word deletes the whole word immediately to the left of the insertion point. 

3 

Delete 

Keep the insertion point just before the character you want to delete and press 

the Delete key. Word deletes the character immediately to the right of the insertion point. 

4 

Ctrl + Delete 

Keep the insertion point just before the word you want to delete and press Ctrl + 

Delete key. Word deletes the word immediately to the right of the insertion point. 

Using Selection Method 

You have learnt how to select various parts of a Word document. You can make use of that learning to 

delete those selected parts as described in the following table − 

S.No Component Selection & Delete Methods 

1 

Deleting text between two points 

Click at the start of the block of text, hold down the Shift key, and click at the end of the 

block to select the portion of text and finally press either the Backspace key or 

the Delete key. 

2 

Deleting a single word 

Double-click anywhere on the word you want to delete and finally press either 

the Backspace key or the Delete key. 
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3 

Deleting a paragraph 

Triple-click anywhere on the paragraph you want to delete and finally press either 

the Backspace key or the Delete key. 

4 

Deleting a sentence 

Hold down the Ctrl key and click anywhere in the sentence you want to delete and finally 

press either the Backspace or the Delete key. 

5 

Deleting a column of text 

Hold down the Alt key, click and hold the mouse button, and drag over the column you 

want to delete and finally press either the Backspace key or the Delete key. 

6 

Deleting a line 

Bring your mouse in the selection bar area and click in front of the line you want to delete 

and finally press either the Backspace key or the Delete key. 

7 

Deleting entire document content 

Press Ctrl + A keys to delete the entire document and finally press either 

the Backspace key or the Delete key. 

Note − The black shaded area in the following screen shot is called the selection bar. When you bring your 

cursor in this area, it turns into a rightward-pointing arrow. 
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Copy & Paste Operation 

The Copy operation will just copy the content from its original place and create a duplicate copy of the 

content at the desired location without deleting the text from it's the original location. Following is the 

procedure to copy the content in word − 

Step 1 − Select a portion of the text using any of the text selection methods. 
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Step 2 − You have various options available to copy the selected text in clipboard. You can make use of 

any one of the options − 

• Using Right-Click − When you right-click on the selected text, it will display the copy option, 

click this option to copy the selected content in clipboard. 

• Using Ribbon Copy Button − After selecting text, you can use the copy button available at the 

ribbon to copy the selected content in clipboard. 

• Using Ctrl + c Keys − After selecting a text, just press Ctrl + c keys to copy the selected content in 

clipboard. 
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Step 3 − Finally click at the place where you want to copy the selected text and use either of these two 

simple options − 

• Using Ribbon Paste Button − Just click the Paste button available at the ribbon to paste the copied 

content at the desired location. 
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• Using Ctrl + v Keys − This is simplest way of pasting the content. Just press Ctrl + v keys to paste 

the content at the new location. 

 

Note − You can repeat the Paste operation as many times as you like to paste the same content. 

Cut & Paste Operation 

The Cut operation will cut the content from its original place and move the content from its original 

location to a new desired location. Following is the procedure to move the content in word − 

Step 1 − Select a portion of the text using any of the text selection methods. 
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Step 2 − Now, you have various options available to cut the selected text and put it in the clipboard. You 

can make use of one of the options − 

• Using Right-Click − If right-click on the selected portion of text, it will display cut option, just 

click this option to cut the selected content and keep it in clipboard. 

• Using Ribbon Cut Button − After selecting a portion of text, you can use cut button available at 

the ribbon to cut the selected content and keep it in clipboard. 

• Using Ctrl + x Keys − After selecting a portion of text, just press Ctrl + x keys to cut the selected 

content and keep it in clipboard. 
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Step 3 − Finally, click at the place where you want to move the selected text and use either of these two 

simple options − 

• Using Ribbon Paste Button − Just click the Paste button available at the ribbon to paste the 

content at the new location. 
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• Using Ctrl + v Keys − This is simplest way of pasting the content. Just press Ctrl + v keys to paste 

the content at the new location. 

 

Note − You can repeat the Paste operation as many times as you like to paste the same content. 

Copy, Cut & Paste in different documents 

You can use the same procedure that we discussed above to copy and pasteor cut and paste content from 

one document to another document. This is very simple, just copy or cut the desired content from one 

document and go into another document where you want to paste the content and use mentioned step to 

paste the content. 

You can use the Alt + Tab keys to switch through the different documents and select the desired destination 

document. 
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Check Spelling and Grammar using Review tab 

Here is the simple procedure to find out the spelling mistakes and fix them − 

Step 1 − Click the Review tab and then click the Spelling & Grammarbutton. 

 

Step 2 − A Spelling and Grammar dialog box will appear and will display the wrong spellings or errors in 

grammar. You will also get suggestions to correct as shown below − 
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Now you have following options to fix the spelling mistakes − 

• Ignore − If you are willing to ignore a word, then click this button and Word ignores the word 

throughout the document. 

• Ignore All − Like Ignore, but this ignores all occurrences of the same misspelling, not just once but 

throughout the document. 

• Add to Dictionary − Choose Add to Dictionary to add the word to the Word spelling dictionary. 

• Change − This will change the wrong word using the suggested correct word. 
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• Change All − Like Change, but this changes all occurrences of the same misspelling, not just once 

but throughout the document. 

• AutoCorrect − If you select a suggestion, Word creates an AutoCorrect entry that automatically 

corrects this spelling error from now on. 

Following are the different options in case you have grammatical mistake − 

• Next Sentence − You can click Next Sentence to direct the grammar checker to skip ahead to the 

next sentence. 

• Explain − The grammar checker displays a description of the rule that caused the sentence to be 

flagged as a possible error. 

• Options − This will open the Word Options dialog box to allow you to change the behavior of the 

grammar checker or spelling options. 

• Undo − This will undo the last grammar changed. 

Step 3 − Select one of the given suggestions you want to use and click the Change option to fix the spelling 

or grammar mistake and repeat the step to fix all the spelling or grammar mistake. 

Step 4 − Word displays a dialog box when it finishes checking for spelling and grammar mistakes, finally 

Click OK. 
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Check Spelling and Grammar using Right Click 

If you will right-click the mouse button over a misspelled word, then it will show you the correct 

suggestions and the above mentioned options to fix the spelling or grammar mistake. Try it yourself. 
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Change the Font Type & Size 

We will understand in brief the font buttons that we will further use in this tutorial. Following is a 

screenshot to show you a few font related buttons. 
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Step 1 − Select the portion of text the font of which needs to be changed and click the Home tab. Now 

click the Font Type button to list down all the fonts available as shown below. 



 
BBA-LLB III Sem.      Subject- Fundamentals of Computer  
 
 
 

 

 
96 

 

 

Step 2 − Try to move the mouse pointer over the listed fonts. You will see that the text font changes when 

you move the mouse pointer over different fonts. You can use the Font Scroll Bar to display more fonts 

available. Finally select a desired font by clicking over the font name in the list. We have selected MV 

Boli as the font for our sample text. 

Copy and Apply Text Formatting 

The following steps will help you understand how to copy and apply text formatting from one portion of 

text in your document to another portion of text in your document. 

Step 1 − Select the portion of text containing the formatting that you want to copy. I have selected a text 

which has bold and underlined font as shown below. 
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Step 2 − click the Home tab and click the Format Painter button to copy the format of the selected text. 

As soon as you click the format painter button, the mouse pointer changes to a paint brush when you move 

the mouse over your document. 

Step 3 − Now you are ready to apply the copied text format to any of the selected text. So select a text using 

mouse where you want to apply the copied text format. While selecting a portion of text, you have to make 

sure that your mouse pointer is still in paint brush shape. After selecting the text, just release the right-click 

button of the mouse and you will see that newly selected text is changed to the format used for the original 

selection. You can click anywhere outside the selection to continue working on your document for further 

editing. 
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Copy and Apply Text Formatting multiple times 

Step 1 − If you are intended to apply formatting at multiple places, then you will have to double-click 

the Format Painter button while copying the text format. Later on, you just keep selecting the text where 

you want to apply the text formatting. 

Step 2 − When you are done with applying formatting at all the places, click Format Painter to come out 

of the format applying operation. 
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Step 3 − Similar way, to change the font size, click over the Font Size button which will display a font size 

list. You will use the same procedure to select a desired font size that you have used while selecting a font 

type. 
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Use Shrink and Grow Buttons 

You can use a quick way to reduce or enlarge the font size. As shown in the first screenshot, the Shrink 

Font button can be used to reduce the font size whereas the Grow Font button can be used to enlarge the 

font size. 

Set Standard Watermark 

The following steps will help you set standard watermark in word document. A standard watermark is the 

one which is already defined by words and cannot modify their font or color etc. 

Step 1 − Open a word document in which you want to add a watermark. 

Step 2 − Click the Page Layout tab and then click the Watermark button to display a list of standard 

watermark options. 
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Step 3 − You can select any of the available standard watermarks by simply clicking over it. This will be 

applied to all the pages of the word. Assume we select the Confidential watermark. 
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Set Custom Watermark 
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The following steps will help you set custom watermark in word document. A custom watermark is the one 

which can be modified text and its font, color and size etc. 

Step 1 − Open a Word document in which you want to add a watermark. 

Step 2 − Click the Page Layout tab and then click the Watermark button to display a list of standard 

watermark options. At the bottom, you will find the Custom Watermark option. 

 

Step 3 − Click over the Custom Watermark option; this will display the Printed Watermark dialog box. 
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Step 4 − Now you can set a picture as watermark or you can set predefined text as watermark; you can also 

type your text in the Text box available at Printed Watermark dialog box. We will set text watermark 

as DUPLICATE and also set its font color and font size. Once all the parameters are set, click 

the OK button to set the parameters. 
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Remove Watermark 

The following steps will help you remove an existing watermark from a Word document. 

Step 1 − Open a Word document the watermark of which needs to be deleted. 

Step 2 − Click the Page Layout tab followed by the Watermark button to display a list of standard 

watermark options. At the bottom, you will find the Remove Watermark option. 
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Step 3 − Click Remove Watermark option; this will delete the existing watermark from the document. 
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Try to click either of these two buttons and you will see the effect. You can click a single button multiple 

times to apply the effect. Each time you click either of the buttons, it will enlarge or reduce the font size by 

1 point. 

Clear Formatting Options 

All of the setting can be reset to plain text, or the default formatting. To reset text to default settings − 

Step 1 − Select the portion of text that you want to reset. 

Step 2 − Click the Clear Formatting button in the Home tab Font group, or simply use Ctrl + 

SPACEBAR. 
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MS-Excel 

 

Microsoft Excel is a commercial spreadsheet application, written and distributed by Microsoft for Microsoft 

Windows and Mac OS X. At the time of writing this tutorial the Microsoft excel version was 2010 for 

Microsoft Windows and 2011 for Mac OS X. 

Microsoft Excel is a spreadsheet tool capable of performing calculations, analyzing data and integrating 

information from different programs. 

By default, documents saved in Excel 2010 are saved with the .xlsx extension whereas the file extension of 

the prior Excel versions are .xls. 

Inserting Data 

For inserting data in MS Excel, just activate the cell type text or number and press enter or Navigation 

keys. 
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Inserting Formula 

For inserting formula in MS Excel go to the formula bar, enter the formula and then press enter or 

navigation key. See the screen-shot below to understand it. 
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Modifying Cell Content 

For modifying the cell content just activate the cell, enter a new value and then press enter or navigation 

key to see the changes. See the screen-shot below to understand it. 
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Row and Column Basics 

MS Excel is in tabular format consisting of rows and columns. 

• Row runs horizontally while Column runs vertically. 

• Each row is identified by row number, which runs vertically at the left side of the sheet. 

• Each column is identified by column header, which runs horizontally at the top of the sheet. 

For MS Excel 2010, Row numbers ranges from 1 to 1048576; in total 1048576 rows, and Columns ranges 

from A to XFD; in total 16384 columns. 

Navigation with Rows and Columns 
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Let us see how to move to the last row or the last column. 

• You can go to the last row by clicking Control + Down Navigation arrow. 

• You can go to the last column by clicking Control + Right Navigation arrow. 

 

Cell Introduction 

The intersection of rows and columns is called cell. 

Cell is identified with Combination of column header and row number. 

For example − A1, A2. 
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Formulas in MS Excel 

Formulas are the Bread and butter of worksheet. Without formula, worksheet will be just simple tabular 

representation of data. A formula consists of special code, which is entered into a cell. It performs some 

calculations and returns a result, which is displayed in the cell. 

Formulas use a variety of operators and worksheet functions to work with values and text. The values and 

text used in formulas can be located in other cells, which makes changing data easy and gives worksheets 

their dynamic nature. For example, you can quickly change the data in a worksheet and formulas works. 

Elements of Formulas 

A formula can consist of any of these elements − 

• Mathematical operators, such as +(for addition) and *(for multiplication) 
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Example − 

o =A1+A2 Adds the values in cells A1 and A2. 

• Values or text 

Example − 

o =200*0.5 Multiplies 200 times 0.15. This formula uses only values, and it always returns 

the same result as 100. 

• Cell references (including named cells and ranges) 

Example − 

o =A1=C12 Compares cell A1 with cell C12. If the cells are identical, the formula returns 

TRUE; otherwise, it returns FALSE. 

• Worksheet functions (such as SUMor AVERAGE) 

Example − 

o =SUM(A1:A12) Adds the values in the range A1:A12. 

Creating Formula 

For creating a formula you need to type in the Formula Bar. Formula begins with '=' sign. When building 

formulas manually, you can either type in the cell addresses or you can point to them in the worksheet. 

Using the Pointing method to supply the cell addresses for formulas is often easier and more powerful 

method of formula building. When you are using built-in functions, you click the cell or drag through the 

cell range that you want to use when defining the function’s arguments in the Function Arguments dialog 

box. See the below screen shot. 
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As soon as you complete a formula entry, Excel calculates the result, which is then displayed inside the cell 

within the worksheet (the contents of the formula, however, continue to be visible on the Formula bar 

anytime the cell is active). If you make an error in the formula that prevents Excel from being able to 

calculate the formula at all, Excel displays an Alert dialog box suggesting how to fix the problem. 

Cell References in Formulas 

Most formulas you create include references to cells or ranges. These references enable your formulas to 

work dynamically with the data contained in those cells or ranges. For example, if your formula refers to 

cell C2 and you change the value contained in C2, the formula result reflects new value automatically. If 

you didn’t use references in your formulas, you would need to edit the formulas themselves in order to 

change the values used in the formulas. 

When you use a cell (or range) reference in a formula, you can use three types of references − relative, 

absolute, and mixed references. 
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Relative Cell References 

The row and column references can change when you copy the formula to another cell because the 

references are actually offsets from the current row and column. By default, Excel creates relative cell 

references in formulas. 

 

Absolute Cell References 

The row and column references do not change when you copy the formula because the reference is to an 

actual cell address. An absolute reference uses two dollar signs in its address: one for the column letter and 

one for the row number (for example, $A$5). 
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Mixed Cell References 

Both the row or column reference is relative and the other is absolute. Only one of the address parts is 

absolute (for example, $A5 or A$5). 

Functions in Formula 

Many formulas you create use available worksheet functions. These functions enable you to greatly enhance 

the power of your formulas and perform calculations that are difficult if you use only the operators. For 

example, you can use the LOG or SIN function to calculate the Logarithm or Sin ratio. You can’t do this 

complicated calculation by using the mathematical operators alone. 

Using Functions 

When you type = sign and then type any alphabet you will see the searched functions as below. 
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Suppose you need to determine the largest value in a range. A formula can’t tell you the answer without 

using a function. We will use formula that uses the MAX function to return the largest value in the range 

B3:B8 as =MAX(A1:D100). 
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Another example of functions. Suppose you want to find if the cell of month is greater than 1900 then we 

can give Bonus to Sales representative. The we can achieve it with writing formula with IF functions 

as =IF(B9>1900,"Yes","No") 
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Function Arguments 

In the above examples, you may have noticed that all the functions used parentheses. The information 

inside the parentheses is the list of arguments. 

Functions vary in how they use arguments. Depending on what it has to do, a function may use. 

• No arguments − Examples − Now(), Date(), etc. 

• One argument − UPPER(), LOWER(), etc. 

• A fixed number of arguments − IF(), MAX(), MIN(), AVERGAGE(), etc. 

• Infinite number of arguments 
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• Optional arguments 

 

 

 

Built In Functions 

MS Excel has many built in functions, which we can use in our formula. To see all the functions by 

category, choose Formulas Tab » Insert Function. Then Insert function Dialog appears from which we 

can choose the function. 
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Functions by Categories 

Let us see some of the built in functions in MS Excel. 

• Text Functions 

o LOWER − Converts all characters in a supplied text string to lower case 

o UPPER − Converts all characters in a supplied text string to upper case 

o TRIM − Removes duplicate spaces, and spaces at the start and end of a text string 

o CONCATENATE − Joins together two or more text strings. 

o LEFT − Returns a specified number of characters from the start of a supplied text string. 

o MID − Returns a specified number of characters from the middle of a supplied text string 
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o RIGHT − Returns a specified number of characters from the end of a supplied text string. 

o LEN − Returns the length of a supplied text string 

o FIND − Returns the position of a supplied character or text string from within a supplied 

text string (case-sensitive). 

• Date & Time 

o DATE − Returns a date, from a user-supplied year, month and day. 

o TIME − Returns a time, from a user-supplied hour, minute and second. 

o DATEVALUE − Converts a text string showing a date, to an integer that represents the 

date in Excel's date-time code. 

o TIMEVALUE − Converts a text string showing a time, to a decimal that represents the 

time in Excel. 

o NOW − Returns the current date & time. 

o TODAY − Returns today's date. 

• Statistical 

o MAX − Returns the largest value from a list of supplied numbers. 

o MIN − Returns the smallest value from a list of supplied numbers. 

o AVERAGE − Returns the Average of a list of supplied numbers. 

o COUNT − Returns the number of numerical values in a supplied set of cells or values. 

o COUNTIF − Returns the number of cells (of a supplied range), that satisfies a given 

criteria. 

o SUM − Returns the sum of a supplied list of numbers 

• Logical 

o AND − Tests a number of user-defined conditions and returns TRUE if ALL of the 

conditions evaluate to TRUE, or FALSE otherwise 

o OR − Tests a number of user-defined conditions and returns TRUE if ANY of the 

conditions evaluate to TRUE, or FALSE otherwise. 
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o NOT − Returns a logical value that is the opposite of a user supplied logical value or 

expression i.e. returns FALSE if the supplied argument is TRUE and returns TRUE if the 

supplied argument is FAL 

• Math & Trig 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers. 

Charts 

A chart is a visual representation of numeric values. Charts (also known as graphs) have been an integral 

part of spreadsheets. Charts generated by early spreadsheet products were quite crude, but thy have 

improved significantly over the years. Excel provides you with the tools to create a wide variety of highly 

customizable charts. Displaying data in a well-conceived chart can make your numbers more 

understandable. Because a chart presents a picture, charts are particularly useful for summarizing a series of 

numbers and their interrelationships. 

Types of Charts 

There are various chart types available in MS Excel as shown in the below screen-shot. 
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• Column − Column chart shows data changes over a period of time or illustrates comparisons 

among items. 

• Bar − A bar chart illustrates comparisons among individual items. 

• Pie − A pie chart shows the size of items that make up a data series, proportional to the sum of the 

items. It always shows only one data series and is useful when you want to emphasize a significant 

element in the data. 

• Line − A line chart shows trends in data at equal intervals. 

• Area − An area chart emphasizes the magnitude of change over time. 

• X Y Scatter − An xy (scatter) chart shows the relationships among the numeric values in several 

data series, or plots two groups of numbers as one series of xy coordinates.  

• Stock − This chart type is most often used for stock price data, but can also be used for scientific 

data (for example, to indicate temperature changes). 
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• Surface − A surface chart is useful when you want to find the optimum combinations between two 

sets of data. As in a topographic map, colors and patterns indicate areas that are in the same range 

of values. 

• Doughnut − Like a pie chart, a doughnut chart shows the relationship of parts to a whole; however, 

it can contain more than one data series. 

• Bubble − Data that is arranged in columns on a worksheet, so that x values are listed in the first 

column and corresponding y values and bubble size values are listed in adjacent columns, can be 

plotted in a bubble chart. 

• Radar − A radar chart compares the aggregate values of a number of data series. 

Creating Chart 

To create charts for the data by below mentioned steps. 

• Select the data for which you want to create the chart. 

• Choose Insert Tab » Select the chart or click on the Chart groupto see various chart types. 

• Select the chart of your choice and click OK to generate the chart. 
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Editing Chart 

You can edit the chart at any time after you have created it. 

• You can select the different data for chart input with Right click on chart » Select data. Selecting 

new data will generate the chart as per the new data, as shown in the below screen-shot. 
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• You can change the X axis of the chart by giving different inputs to X-axis of chart. 

• You can change the Y axis of chart by giving different inputs to Y-axis of chart. 

 

Formatting Cells 

In MS Excel, you can apply formatting to the cell or range of cells by Right Click » Format cells » Select 

the tab. Various tabs are available as shown below 
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Alternative to Placing Background 

• Number − You can set the Format of the cell depending on the cell content. Find tutorial on this 

at MS Excel - Setting Cell Type. 

• Alignment − You can set the alignment of text on this tab. Find tutorial on this at MS Excel - Text 

Alignments. 

• Font − You can set the Font of text on this tab. Find tutorial on this at MS Excel - Setting Fonts. 

• Border − You can set border of cell with this tab. Find tutorial on this at MS Excel - Borders and 

Shades. 

• Fill − You can set fill of cell with this tab. Find tutorial on this at MS Excel - Borders and Shades. 

• Protection − You can set cell protection option with this tab. 

https://www.tutorialspoint.com/excel/excel_setting_cell_type.htm
https://www.tutorialspoint.com/excel/excel_text_alignments.htm
https://www.tutorialspoint.com/excel/excel_text_alignments.htm
https://www.tutorialspoint.com/excel/excel_setting_fonts.htm
https://www.tutorialspoint.com/excel/excel_borders_and_shades.htm
https://www.tutorialspoint.com/excel/excel_borders_and_shades.htm
https://www.tutorialspoint.com/excel/excel_borders_and_shades.htm
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MS – Power-Point 

 

Explore Windows in Powerpoint 2010 

The following screenshot shows the various areas in a standard PowerPoint file. It is important to 

familiarize yourself with these areas as it makes learning and using PowerPoint easier. 
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File Tab 
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This tab opens the Backstage view which basically allows you to manage the file and settings in 

PowerPoint. You can save presentations, open existing ones and create new presentations based on blank or 

predefined templates. The other file related operations can also be executed from this view. 

Ribbon 

 

The ribbon contains three components − 

• Tabs − They appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are examples of ribbon tabs. 

• Groups − They organize related commands; each group name appears below the group on the 

Ribbon. For example, a group of commands related to fonts or a group of commands related to 

alignment, etc. 

• Commands − Commands appear within each group as mentioned above. 

Title Bar 

This is the top section of the window. It shows the name of the file followed by the name of the program 

which in this case is Microsoft PowerPoint. 

Slide Area 

This is the area where the actual slide is created and edited. You can add, edit and delete text, images, 

shapes and multimedia in this section. 

Help 

The Help Icon can be used to get PowerPoint related help anytime you need. Clicking on the "?" opens the 

PowerPoint Help window where you have a list of common topics to browse from. You can also search for 

specific topics from the search bar at the top. 
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Zoom Options 

The zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that 

you can slide left or right to zoom in or out, you can click on the - and + buttons to increase or decrease the 

zoom factor. The maximum zoom supported by PowerPoint is 400% and the 100% is indicated by the mark 

in the middle. 

Slide Views 

The group of four buttons located to the left of the Zoom control, near the bottom of the screen, lets you 

switch between PowerPoint views. 

• Normal Layout view − This displays page in normal view with the slide on the right and a list of 

thumbnails to the left. This view allows you to edit individual slides and also rearrange them. 

• Slide Sorter view − This displays all the slides as a matrix. This view only allows you to rearrange 

the slides but not edit the contents of each slide. 

• Reading View − This view is like a slideshow with access to the Windows task bar in case you 

need to switch windows. However, like the slideshow you cannot edit anything in this view. 

Notes Section 

This sections allows you to add notes for the presentation. These notes will not be displayed on the screen 

during the presentation; these are just quick reference for the presenter. 

Quick Access Toolbar 

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient place to group 

the most commonly used commands in PowerPoint. You can customize this toolbar to suit your needs. 

Slide Tab 

This section is available only in the Normal view. It displays all the slides in sequence. You 

can add, delete and reorder slides from this section. 

Backstage View in Powerpoint 2010 

In Office 2010, Microsoft replaced the traditional file menu with the new Backstage view. This view not 

only offers all the menu items under the file menu, but additional details which makes management of your 

files a lot easier. 

Accessing Backstage View 
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You can access the Backstage view simply by clicking on the File tab. You can exit this view by clicking on 

any tab (including the File tab again). You can also press the 'Esc' button on the keyboard. 

 

Organization of Backstage View 

The backstage view has three sections or panes. 
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• First Pane − This is the commands pane which consists of all the commands you would typically 

find in the file menu of older versions. You also have the Options menu which lets you edit the 

options on the program like customizing the ribbon. 

Various commands under the first pane are described in the table below − 

S.No Command & Description 
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1 Save 

This allows you to save a new file or an existing file in standard format. If you are working 

on a previously saved file this will save the new changes in the same file format. If you are 

working on a new file, this command would be similar to the Save As command. 

2 Save As 

Allows you to specify the file name and the file type before saving the file. 

3 Open 

Allows you to open new PowerPoint files. 

4 Close 

Allows you to close an existing file. 

5 Info 

Displays the information about the current file. 

6 Recent 

Lists series of recently viewed or edited PowerPoint files. 

7 New 

Allows you to create a new file using blank or pre-defined templates. 

8 Print 

Allows you to select the printer settings and print the presentation. 

9 Save & Send 

Allows you to share your presentation with larger audience via emails, web, cloud services, 
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etc. 

10 Help 

Provides access to PowerPoint Help. 

11 Options 

Allows you to set various options related to PowerPoint program. 

12 Exit 

Closes the presentation and exits the program. 

• Second Pane − This is the subcommands pane. This will list all the commands related to the main 

command you choose in the first pane. For example, if you select Print in the first pane, you get to 

choose the printer and adjust the print settings in the second pane. 

• Third Pane − This is the preview or file information page. Depending on the command and the 

subcommand you select, this pane will either display the properties of the file or give you a preview 

of the file. 

Create Presentation using Powerpoint 2010 

PowerPoint offers a host of tools that will aid you in creating a presentation. These tools are organized 

logically into various ribbons in PowerPoint. The table below describes the various commands you can 

access from the different menus. 
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Menu Category Ribbon Commands 

Home Clipboard functions, manipulating slides, fonts, paragraph settings, 
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drawing objects and editing functions. 

Insert Insert tables, pictures, images, shapes, charts, special texts, multimedia 

and symbols. 

Design Slide setup, slide orientation, presentation themes and background. 

Transitions Commands related to slide transitions. 

Animations Commands related to animation within the individual slides. 

Slide Show Commands related to slideshow set up and previews. 

Review Proofing content, language selection, comments and comparing 

presentations. 

View Commands related to presentation views, Master slides, color settings and 

window arrangements. 

Besides these depending on the objects selected in the slide, there are other menu tabs that get enabled. 

Add New Slides in Powerpoint 2010 

In this chapter, we will understand how to add new slides in an existing presentation. Here are the steps that 

allow you to insert a new slide in the deck − 

Step 1 − Right-click in the Navigation Pane under any existing slide and click on the New Slide option. 
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Step 2 − The new slide is inserted. You can now change the layout of this slide to suit your design 

requirements. 
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Step 3 − To change the slide layout, right-click on the newly inserted slide and go to the Layout option 

where you can choose from the existing layout styles available to you. 
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You can follow the same steps to insert a new slide in between existing slides or at the end on the slide list. 

When we insert a new slide, it inherits the layout of its previous slide with one exception. If you are 

inserting a new slide after the first slide (Title slide), the subsequent slide will have the Title and 

Content layout. 
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You will also notice that if you right-click in the first step without selecting any slide the menu options you 

get are different, although you can insert a new slide from this menu too. 

 

Adding Text in Boxes in Powerpoint 2010 

PowerPoint allows users to add text to the slide in a well-defined manner to ensure the content is well 

distributed and easy to read. The procedure to add the text in a PowerPoint slide is always the same - just 

click in the text box and start typing. The text will follow the default formatting set for the text box, 

although this formatting can be changed later as required. What changes is the different kinds of content 

boxes that support text in a PowerPoint slide. 

Given below are some of the most common content blocks you will see in PowerPoint. 

Title Box 
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This is typically found on slides with the title layout and in all the slides that have a title box in them. This 

box is indicated by "Click to add title". 

 

Subtitle Box 

This is found only in slides with the Title layout. This is indicated by "Click to add subtitle" 

Content Box 

This is found in most of the slides that have a placeholder for adding content. This is indicated by "Click to 

add text". As you can see, this box allows you to add text as well as non-text content. To add text to such a 

box, click anywhere on the box, except on one of the content icons in the center and start typing. 
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Text Only Box 

This is not a default content box available in PowerPoint, but you can create it using Slide Master, if 

required. This is also indicated by "Click to add text". The only difference between the Text Only Box and 

the Content Box is that the former only supports text in the content area. 
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Adding New Text Boxes in Powerpoint 2010 

This chapter will teach you how to add new text boxes in a slide. Most of the standard layouts come with 

the text box option. As mentioned in the previous chapter, text boxes will have "Click to add text" as the 

default text. Here are the steps to add new text boxes in slide. 

Step 1 − Click on the Text Box icon in the Home ribbon under the Drawingsection. 
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Step 2 − You will get the insert text box cursor that looks like an inverted cross. 

Step 3 − Click to insert a text box. You can now start typing directly into the text box. 
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Step 4 − Alternately, you can click and drag the cursor without releasing the click to create a text box. 
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The size of the text box can be adjusted by selecting one of the edges marked by squares or corners marked 

by circles. 
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Deleting Existing Slide in Powerpoint 2010 

There are times while building a slide deck, you may need to delete some slides. This can be done easily 

from PowerPoint. You can delete the slides from the Normal view as well as the Slide Sorter view. In each 

view, you can delete the slides in two ways. 

Deleting from Normal View 

Step 1 − Go to the Normal view. 
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Step 2 − Right-click on the slide to be deleted and select the Delete Slideoption. 
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Alternately, you can select the slide and press the Delete button on your key board. 

Deleting from Slide Sorter View 

Let us now understand how to deleted slides from the Slide Sorter View. 

Step 1 − Go to the Slide Sorter view. 
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Step 2 − Right-click on the slide to be deleted and select the Delete Slideoption. 
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Alternately, you can select the slide and press the Delete button on your key board. 

Rearranging Slides in Powerpoint 2010 

Rearranging slides is important when it comes to organizing the overall presentation flow. While it is vital 

that you get the right content in every slide, it is equally important that you are able to present them in a 

format that makes it easier for the audience to understand the content too; most times this will require 

rearranging the slides. 

You can rearrange slides from two views in PowerPoint - Normal View and Slide Sorter View. Given 

below are the steps to rearrange slides from different views. 

Normal View 
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Step 1 − Select the slide to be moved. 

Step 2 − Left click on the slide and drag it to the position in the sequence where you want to place it. 

PowerPoint will indicate the insert position with a line in-between existing slides. 

 

Step 3 − When you get to the right position release the left click button to insert the slide. Alternately you 

can also cut the selected slide and paste it back in the sequence as shown below. 
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Slide Sorter View 

Let us now understand how the Slide Sorter View works. 

Step 1 − Select the slide to be moved. 

Step 2 − Left click on the slide and drag it to the position in the sequence where you want to place it. 

PowerPoint will indicate the insert position with a line in-between existing slides. 



 
BBA-LLB III Sem.      Subject- Fundamentals of Computer  
 
 
 

 

 
162 

 

 

Step 3 − When you get to the right position release the left click button to insert the slide. Alternately you 

can also cut the selected slide and paste it back in the sequence as shown below. 
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